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Prerequisites and System

Requirements

1 Texas Foster Care/Residential System/GCM

System

Must have an active Texas Foster Care or Residential system

already configured in extendedReach

2 Full Administrator Permissions

Requires an extendedReach User ID with Full Administrator user

permissions to access configuration settings

3 System Evaluation Readiness

Prepared to assess current feature usage and determine

configuration needs for T3C compliance



Program Categories and Custom Fields Configuration

Program Categories Assessment

Review your ability to add program categories and subcategories for both legacy and

T3C requirements. If possible, add categories for credentialed service packages and

update existing program reports to include new categories.

Custom Fields Evaluation

Examine current program custom field usage and availability. Determine if you have

sufficient extra fields to accommodate T3C requirements, or if a new program

addition is necessary.



Categories and Subcategories

Subcategory Formula
@If(CC_Category="Treatment Services";"ED (Emotional Disorder) | ED":"ID
(Intellectual Disability) | ID":"ASD (Autism Spectrum Disorder) | ASD":"PMN
(Primary Medical Needs) | PMN":"TV (Trafficking Victim) |
TV";CC_Category="T3C - Basic Foster Family Home Support Services":"T3C -
Short-Term Assessment Support Services":"T3C - Mental & Behavioral Health
Support Services":"T3C - Complex Medical Needs or Medically Fragile
Support Services":"T3C - Intellectual or Developmentally Disability
(IDD)/Autism Spectrum Disorder Support Services":"T3C - Treatment Foster
Family Care Support Services";"A. Transition Support for Youth and Young
Adults":"B. Kinship Caregiver Support":"C. Pregnant and Parenting
Youth":"D. None":"Treatment Services: ED (Emotional Disorder) |
ED":"Treatment Services: ID (Intellectual Disability) | ID":"Treatment
Services: ASD (Autism Spectrum Disorder) | ASD":"Treatment Services: PMN
(Primary Medical Needs) | PMN":"Treatment Services: TV (Trafficking Victim)
| TV";"")
• Formula is plug and play. Just change the words inside the parenthesis

“xxx”, or add a colon and new parenthesis to add legacy options.



Referral Tracking and Respite Management

Referral System Setup

Enable referral tracking if not currently active and add necessary denial reasons for T3C compliance. 2 Places in eR to

configure:

Uncheck box below

Program Settings > Setup Tab

Org Settings > Org Preferences > Settings Tab

Reporting Configuration

Configure reporting for pending and rejected referrals to maintain comprehensive tracking

Respite Home Tracking

Ensure respite tracking covers both legacy and T3C placements with appropriate payment configurations

-Rates for legacy and T3C in Programs > Program Rate Sheets

Org Settings > Org Prefs > Settings > Scroll down and select.

May need a zero-dollar rate for when Homes have more than 40 hrs-respite/year.



Foster Parent Training and Provider Types

Training Hours Configuration

Configure Foster Parent Training Hours to meet

both legacy and new T3C requirements. Custom

formulas available through Customer Success

Manager if needed.

Provider Type Matching

Add provider types that align with credentialed

service packages for T3C. Update existing home

reports and Foster Family Website access

accordingly.

License Type Updates

Establish license types that correspond to T3C

service packages and update home reports with

new license triggers.



Organization Custom Fields

and License Management

1 Field Assessment

Evaluate current organization and program custom field

usage and available capacity for T3C additions

2 License Configuration

Add license types matching T3C service packages and

update associated reports

3 System Integration

Ensure all new configurations work seamlessly with existing

home reports and activities



ExtendedReach Support Services

Funding

Organizations

Email Support to add required funding

organizations to your T3C programs.

These will be your SSCCs you contract

with

Enterprise Financials

Contact Customer Success

Manager for T3C enterprise

financial setup assistance

Rate Sheets & Reports

Custom import services for

service package rates and

Zoho report templates for

outcome tracking

Revision Tracking

Email Support to ask what

revisions are currently enabled

in your system. Revisions

enable date tracking for case

and home file changes required

for T3C compliance. ex.

Categories, subcategories,

custom fields

Revisions

Any field in eR can have a

revision date added. Revisions

allow you to backdate when a

particular field changes. eR will

track all revisions under the

Case File and Home File Tab

(sort by revisions)



Implementation Decision
Framework

Evaluate Current Capabilities

Review each feature against T3C requirements using the provided assessment

questions. Determine if existing configurations can accommodate new needs or if system

expansion is necessary. Whispering Pines Consulting can help evaluate your system for

efficiency.

Configure or Expand

If current features are sufficient, proceed with configuration using linked help articles.

If not, consider adding new programs or organizations while consulting with your

Customer Success Manager.

Implement and Monitor

Execute chosen configuration strategy, ensuring all T3C requirements are met

while maintaining efficient record tracking. Utilize extendedReach support

services as needed for specialized implementations.



Logic Models and Outcome

Measurement

Bolded outcomes should be incorporated into Logic Models - but how to

define/measure will be specific to each agency - below are some internal

eR report examples:
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Safety Outcome Measurement

Casework -> Incidents -> By Type Abuse/Neglect

Track and measure incidents categorized as abuse or neglect to ensure safety standards

are maintained.

Casework -> Incidents -> By Type -> Restraints

Monitor the frequency and circumstances of restraint usage to minimize restrictive

interventions.

Casework -> Incidents -> By Type -> Injury

Document and analyze injury incidents to identify patterns and implement preventative

measures.

Casework -> Placements -> By Subsequent Placement

Evaluate placement stability and transitions to ensure safe and appropriate environments.



Permanency Outcome

Measurement

Discharge

D/C Outcome = Permanency Goal

Discharge -> D/C Outcome = Permanency Goal



Well-Being Outcome

Measurement

Specific Activities Completed

Medical, Dental, Therapy, etc.

Compliance with Healthcare Appts.

Tracking attendance and follow-through with scheduled

appointments

Service Plan Goal Progress

Tx Tab -> Casework -> Treatment Goals or Zoho



Implementation

Requirements

Required Documentation

Also - ensure that agencies are using the TX Single Child Plan of

Service custom form. Reach out to your Customer Success

Manager to copy the custom form into your system. It comes field

coded

Consistent Reporting

Maintain standardized documentation practices across all cases

Regular Updates

Keep service plans current with client progress and changing needs



Understanding User

Management in

extendedReach

Managing access to your organization's data requires a clear understanding

of how user accounts work in extendedReach. This presentation explores

the critical difference between User IDs and Staff Profiles, how they function

together, and best practices for managing them effectively within your

organization.
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User ID: The Gateway to Access

Login Credentials

Consists of a unique email address and password that allows employees to

access the extendedReach system

Security Permissions

Determines what the user can see and what actions they can perform within

the system

Workspace Configuration

Controls the layout and available features visible to each user upon login

Deletion Required

Must be deleted when staff leave to prevent unauthorized access (cannot be

disabled or made inactive)



Staff Profile: The Digital Personnel File

Core Functions

The Staff Profile serves as the digital "staff record" or "HR

file" within extendedReach. It stores essential information

about each staff member and connects them to their work in

the system.

• Stores digital signature for approvals

• Tracks credentials and qualifications

• Records contact information and emergency contacts

• Maintains employment history including hire date

Document Management

Staff Profiles enable comprehensive tracking of employee

documentation and professional development requirements.

• Stores staff-related documents

• Tracks training completions and hours

• Monitors certification expiration dates

• Generates alerts for upcoming renewals



When Staff Profiles Are Required

Documentation Creation & Approval

Staff who need to perform or approve activities and reports must have a Staff

Profile

Case & Home Assignment

Staff who need to be assigned to cases or homes as primary workers require a

Staff Profile

Supervisory Responsibilities

Staff who serve as supervisors for other staff members need a Staff Profile

Performance Tracking

Activities and reports are tied to Staff Profiles, not User IDs, for accountability



The Relationship Between User IDs and Staff

Profiles

Creation

Staff Profiles can be automatically

created when setting up a new User

ID

Connection

User IDs can be linked to existing

Staff Profiles to grant system access

Deactivation

When a User ID is deleted, you're

prompted to make the linked Staff

Profile inactive

Preservation

Inactive Staff Profiles maintain

historical record of staff work while

preventing new assignments



Special Cases in User Management

Staff Profile Without User ID

For staff whose documents and

training need tracking, but who don't

need system access. This allows HR

tracking without granting login

credentials.

User ID Without Staff Profile

For roles requiring view-only access

like auditors or executives who need

to see reports but won't be assigned

cases or completing documentation.

Multiple User IDs

In rare cases, one staff member

might need multiple User IDs to

access different organization

instances, though a single Staff

Profile should be maintained.



Privacy and Security
Considerations

Visibility of Staff Information

Full Administrators and Restricted Staff Administrators with access to the

Staff Directory can see all personal information in Staff Profiles

Document Access

Administrators can view all documents and training files uploaded to any

Staff Profile

User ID Security

User IDs must be deleted promptly when staff leave to prevent unauthorized

access to the system

Permissions Management

Regular review of user permissions ensures staff only have access to

information necessary for their roles



Best Practices for User Management

1

Regular Audits

Conduct periodic reviews of active User IDs and Staff Profiles to ensure they match current employment records

2

Prompt Termination

Delete User IDs immediately when staff leave your organization to maintain system security

3

Clear Documentation

Maintain thorough records of which staff require both User IDs and Staff Profiles based on their job functions

4

Role-Based Setup

Configure security permissions based on standardized role definitions rather than individual preferences



Foster Care: Adding a User

ID to extendedReach

This comprehensive guide will walk you through the process of adding a

User ID to the extendedReach foster care management system. A User

ID is the essential first step for granting new employees access to the

system and ensuring proper security protocols are followed.

Whether you're adding basic system access or preparing for full case

management capabilities, understanding the User ID creation process is

crucial for effective system administration and maintaining organizational

security standards.
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Understanding User ID

Requirements

System Access Foundation

A User ID is required for any employee to access the extendedReach

software system, serving as the fundamental building block for system

entry.

Basic vs. Advanced Access

Employees needing only system access require just a User ID, while

those working with cases need both a User ID and a staff profile.

Administrative Prerequisites

Only Agency Administrators can create User IDs through the

Administration section in Organization Settings.



Security Level Requirements
and Access

Verify Administrator Status

Confirm you have Agency Administrator privileges to access the

Administration section on the left side of your Workspace.

Navigate to Organization Settings

Click on "Organization Settings" from the Administration menu to

access user management tools.

Access User ID Management

Select "User IDs" from the Organization Settings menu to begin

the user creation process.



Creating a New User ID

Initiate User Creation

Within the User IDs section, click on "Add User ID" to begin the new user setup process.

Complete Required Information

Fill out all highlighted required fields while optional fields can be completed as needed for your organization.

Save and Finalize

Press SAVE to complete the User ID creation process and activate the new account.



User Information and Login Details

User Information Requirements

Complete the staff member's last name, first name, middle initial,

organization, and job title. Note that relocating a staff member to a new

organization requires deleting and recreating their User ID.

Login Configuration

Enter the work email address for system login, create a password with

confirmation, and configure options for password changes, welcome

emails, staff profiles, and inbox creation as needed.



Workspace Setup and Role

Assignment

Administrative Support

Configure portlets for active referrals and awaiting approval items. Include medical

information restriction option for subcontractors.

Case/Licensing Worker

Set access to all cases versus assigned cases only, configure licensed homes visibility, and

enable active referrals portlet.

Supervisor

Choose between viewing only supervised workers or all workers, configure report approval

access, and set up referrals and approval portlets.

House Worker/Parent

Direct Care or House Parents-Use the Homes field to specify which homes or facilities the

user should have access to for their role.



Security Rights and Permissions

1

Administrator Level

Full, Restricted, or no administrative access

2
Group Permissions

Pre-configured permission sets for efficiency

3
Apply Profile

Auto-populate typical role permissions

4
Navigation Rights

Organization-wide access marked with asterisk

5
Miscellaneous Permissions

Additional customizable user permissions



Permissions



Additional Configuration Options

Weekly Status

Email

Configure automated

weekly emails for cases

and homes to keep

stakeholders informed of

system activity and

updates.

File Manager Setup

eR Plugin serves as the

default proprietary

software allowing users

to edit documents directly

within the

extendedReach

database.

Download Folder

Designate the temporary

location where

extendedReach holds

files during editing

processes in eR Plugin

for seamless document

management.

Inbox Creation

If you selected "Create

and link Inbox" during

setup, an inbox will

automatically be created

when you save the User

ID.



Foster Care - Adding a Staff

Profile

This presentation will guide you through the process of adding a Staff Profile

in the extendedReach system. We'll cover an introduction to staff profiles, an

overview of what they contain, security requirements, and the step-by-step

process to create a new staff profile.
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Introduction

Purpose

This article is meant to assist you with adding a Staff Profile.

Support

If you have a question not addressed here, contact support at

support@extendedreach.com.

mailto:support@extendedreach.com


Overview of the Staff Profile

What is a Staff Profile?

When a new employee's role includes working with cases, this

employee will require a Staff Profile. A Staff Profile is essentially a

professional record that collects information such as: signature,

credentials, phone numbers, hire date, and other information.

Implementation Order

ALWAYS start with the User ID so the system creates the Staff

Profile and Inbox automatically



Adding a Staff Profile Security

Level Requirements and

Access

Administrator Access Required

You must be an Agency Administrator to access "Administration" on the

left side of your Workspace.

Navigate to Organization Settings

Go to "Organization Settings" in the Administration menu.

Access Staff Section

Click on "Staff" to access staff management functions.



3 Steps to Creating a New Staff Profile

Within Staff, click on "Add Staff"

Begin the process by clicking the Add Staff button in the Staff section.

Within the General screen, complete the fields

Required fields are highlighted, while optional fields are not.

Complete sections for "General Information", "Personal Information", "Emergency

Contact", and "Signature".
Press SAVE to complete Adding a Staff Profile

After filling in all required information, save the profile to complete the process.



Staff Profile Field Descriptions

Status

Leave status "Active" if staff is

currently employed. For more

information on "Inactivating" Status,

please see Deleting a

User/Employee Leaves Agency in

Related Articles.

User ID

This is where you can link this Staff

Profile to an existing User ID. For

more information on Adding a User

ID, please see Related Articles.

Termination Date

Click on small calendar icon to open

calendar. Select date of termination

from the calendar.

Agency

This should pre-fill with your agency

name.

Supervisor

You can select which supervisor, if

any, will supervise this staff member.

Type

You can access the drop-down menu

to select the staff type.

Intake Worker

Check this box if this Staff Profile is

for an Intake Worker only, indicating

that this worker is only doing intakes

so they will not be counted as a

caseworker change in the stats.

Does Not Perform Casework

Check this box if this Staff member

will NOT be performing casework.

This means the staff will not be

available on the drop-down menu to

complete activities and reports for

homes and cases.



Completing the Staff Profile

Complete All Fields

Ensure all required fields are filled in correctly

Review Information

Double-check all entered information for accuracy

Press SAVE

Press SAVE to complete Adding a Staff Profile



Removing Employee Access
from extendedReach: A Step-
by-Step Guide

Proper offboarding is crucial for maintaining data security and system integrity

when an employee leaves your agency. This guide will walk you through the

essential steps to ensure departing staff members can no longer access your

extendedReach system while preserving their work history for compliance and

record-keeping purposes.

As an Agency Administrator, you'll learn the complete process from removing

login credentials to updating staff records, helping you maintain control over

your sensitive information and comply with security best practices.
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Understanding the Two-Step Process

2

Critical Steps

Required to completely remove system access

1

Security Level

Agency Administrator access required

100%

Protection

Complete system lockout when properly executed

When an employee departs from your agency, you must complete both steps of the offboarding process to

ensure complete system security. First, deleting their User ID immediately prevents any further system access.

Second, marking their Staff Profile as inactive preserves their work history while removing them from active

assignments and approvals.

Only users with Agency Administrator privileges can perform these actions, as they require access to the

Organization Settings section under Administration in your workspace. Completing both steps ensures 100%

protection against unauthorized access while maintaining your historical records.



Accessing Administrative Controls

Log into extendedReach

Use your Agency Administrator

credentials to access the system with

full administrative privileges.

Navigate to Administration

Locate and click on the

"Administration" option in the left

navigation panel of your workspace.

Select Organization Settings

Click on "Organization Settings" to

access user management functions

and begin the employee removal

process.

To begin the process of removing an employee's access, you'll need to navigate to the administrative section of extendedReach. This

area contains the tools necessary for managing user accounts and staff profiles, but is only accessible to users with Agency

Administrator security clearance.

The Organization Settings section serves as your central hub for all user management tasks, including both steps of the employee

removal process: User ID deletion and Staff Profile deactivation. Ensuring you have the proper access before beginning will prevent

frustration and delays in completing this critical security task.



Step 1: Deleting the User ID

Access User IDs

From Organization Settings, click on "User IDs" to view all system users

Locate Employee

Find and click the blue hyperlink containing the departing employee's name

Delete User ID

Click "Delete" from the top menu bar and confirm by selecting "OK"

Verify Removal

Confirm the user no longer appears in the active User IDs list

Deleting the User ID is the first critical step in removing system access. This action immediately prevents the departing employee from logging into extendedReach, effectively locking them out of all

system functions and sensitive data. The process is straightforward but requires careful attention to ensure you're selecting the correct user account.



Confirming User ID Deletion

Immediate System Lockout

Once the User ID is deleted, the employee can no

longer log into extendedReach with their credentials,

providing immediate security protection.

Verification Process

After deletion, return to the User IDs list to verify the

employee's name no longer appears among active

users in your system.

Deletion vs. Deactivation

User ID deletion is permanent and cannot be undone.

If the person might return to your agency in the future,

consider consulting with your IT department about

alternatives.

When you delete a User ID, the system will display a confirmation dialog to ensure this intentional action isn't performed accidentally. This step is irreversible, so verify you're working

with the correct user record before proceeding. After clicking "OK" on the confirmation prompt, the system will process the deletion and return you to the User IDs list.

The first security gate is now closed, but you must still complete the second step to ensure the employee is fully removed from active assignments and approval workflows within the

system.



Step 2: Inactivating the Staff Profile

Navigate to Staff Profiles

Return to Organization Settings and select "Staff Profiles"

Locate Employee Record

Click the blue hyperlink for the departing staff member

Change Status to Inactive

Under the General tab, click "Status" and select "Inactive" from the dropdown

Save the Changes

Click the SAVE button to apply the status change

While deleting the User ID prevents system access, inactivating the Staff Profile ensures the employee no longer appears in active workflows, assignments, or approval processes. This critical second step maintains the integrity of your historical records while removing the

employee from day-to-day operations.

By marking the profile as inactive rather than deleting it, you preserve all the employee's historical work, notes, and case activities for auditing and compliance purposes. This approach supports proper documentation while ensuring the departed employee is no longer

assigned to active work.



Completing Staff Profile Inactivation

1

Set Status to Inactive

Change the status dropdown to "Inactive" and save the profile

Record Preservation

Work history is maintained for auditing and compliance purposes

Removal from Dropdowns

Employee no longer appears in assignment and approval options

Verification

Confirm status change appears correctly in the system

After setting the employee's Staff Profile to "Inactive" and saving the change, the system will update their status throughout extendedReach. The interface will refresh to display the updated profile with its inactive

status clearly indicated. This change preserves all historical information while preventing the profile from appearing in active staff selections throughout the application.

The benefit of this approach is that you maintain complete records of the employee's work while ensuring they don't appear in dropdown menus for new assignments, approvals, or other active workflows. This

status change completes the second phase of properly removing employee access from your system.



Final Verification and Reassignment

Verify Both Steps Are Complete

Confirm both User ID deletion and Staff Profile inactivation

have been successfully completed.

Check Active Assignments

Review cases and homes to identify any still assigned to

the departed employee.

Reassign Open Cases

Transfer any active cases or homes to current staff

members to ensure continuity of service.

Document Completion

Record the access removal and reassignments in your

offboarding documentation for audit purposes.

After completing both steps of the access removal process, it's essential to verify the employee is no longer assigned to any active cases

or homes. These lingering assignments could cause confusion or delays in service if not properly transferred to current staff members.

Navigate to any cases or homes previously managed by the departed employee and reassign them to appropriate active staff.

This final verification step ensures complete removal of the employee from all system functions while maintaining service continuity for

your clients. For compliance and security audit purposes, document the completion of all steps, including the date of access removal and

case reassignments. If you encounter any issues during this process, contact extendedReach Support at support@extendedreach.com

for assistance.

mailto:support@extendedreach.com


Simplifying User

Management: Foster Care

User Groups in

extendedReach

Welcome to extendedReach's comprehensive guide to User Groups in

Foster Care. This presentation will walk you through how to effectively

manage user permissions across your agency using security groups,

saving you valuable time and ensuring consistency in user access

controls.
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Why Use Security Groups?

Time-Saving Management

Change permissions for multiple users at once instead of making separate

changes for each individual user ID

Consistent Security

Ensure standardized access rights for similar roles across your organization

Role-Based Access

Create specific permission sets based on staff roles (e.g., "Staff," "Supervisors,"

"Leadership")

Centralized Control

Maintain and update permissions from a single location for better oversight

Security Groups are particularly valuable for larger agencies where manually configuring

individual user permissions would be time-consuming and error-prone.



Enabling Security Groups

Plan Your Group Structure

Before enabling, consider the types

of users in your agency and what

permissions each role should have.

Think about group names like

"Staff," "Supervisors," and

"Leadership."

Access Organization

Preferences

Hover over Organization Settings in

your workspace menu and click

"Organizational Preferences" to

begin.

Edit Settings

Navigate to the Settings tab and

click the "Edit" button at the top of

the screen to make changes.

Enable the Feature

Scroll down to Additional Settings

and check the box next to "Enable

User Security Groups" to activate

this functionality.

Note that you must be an Agency Administrator to enable and configure security groups in the system.



Creating User Security Groups

Access User Groups

After enabling the feature, find "User Groups" under Organization Settings in your

workspace menu.

Add a New Group

Click on "Add User Group" to begin creating a new security group profile.

Configure Group Information

Enter a descriptive name and detailed description for the security group that

clearly identifies its purpose.

Set Security Rights

Check the appropriate boxes to configure which specific permissions members of

this group will have in the system.

When setting up security groups, consider creating a hierarchy that allows for appropriate

access based on staff responsibilities and roles within your organization.



Managing Security Group Settings

Security Rights Configuration

The Security Rights section allows you to define specific

permissions for the group. These include:

• Case management capabilities

• Document access and editing rights

• Report generation permissions

• Financial information access

• System administration capabilities

Review these settings carefully to ensure they align with the

role responsibilities of group members.

Accessing Group Management

To view or modify existing groups:

1. Navigate to Organization Settings

2. Click on "User Groups"

3. Select a blue hyperlinked group name

4. Click "Edit" to make changes

5. Save your modifications

This interface provides a quick overview of all user groups,

including member count, descriptions, and when each group

was last modified.

Remember that changes to a security group affect all users assigned to that group, so consider the impact before making

modifications.



Assigning Users to Security Groups

Access User ID

Navigate to the user's profile that you want to assign to a security group and click "Edit" to modify

their settings.

Locate Security Rights

Scroll down to the Security Rights section within the user profile to view current permissions and

group assignments.

Select Security Group

Use the dropdown menu to choose the appropriate security group for the user based on their role

and responsibilities.

Custom Permissions

If a user needs unique permissions, select "No Group Assigned" to customize their individual access

rights outside of the group structure.

When you assign a user to a security group, their individual permission settings become locked based on

the group's configuration, ensuring consistency across similar roles.



Best Practices for Security Groups

Effective security group management balances operational efficiency with appropriate access controls to protect sensitive client information.

Document Your Structure

Create clear documentation that

outlines each security group's

purpose, permissions, and which staff

roles should be assigned to it.

Limit Group Number

Create only as many groups as

necessary to maintain simplicity while

addressing your organization's needs.

Regular Reviews

Schedule periodic reviews of security

groups to ensure they remain aligned

with your organization's evolving

requirements. Principle of Least Privilege

Assign only the minimum permissions

necessary for users to perform their

job functions effectively.



Restricting Access to

Activities and Reports in

extendedReach

extendedReach offers powerful controls to protect sensitive information

within the system. This presentation will guide system administrators through

the process of configuring user access restrictions to ensure confidential

case information is only visible to authorized personnel. You'll learn how to

implement security settings at both individual and group levels to maintain

compliance with privacy regulations.
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Understanding Confidential
Information Protection

What Can Be Protected

Case notes, file attachments, and

specific activity types can be restricted

based on user permissions, ensuring

sensitive client data remains

confidential.

Who Needs Protection

Client medical information, therapy

notes, legal documents, and other

sensitive personal data often require

additional security controls beyond

standard permissions.

Benefits of Restrictions

Properly configured access controls help maintain client privacy, ensure regulatory

compliance, and provide appropriate information access based on staff roles.

With extendedReach's confidential information settings, you can create a secure environment

that respects both client privacy and operational needs while maintaining appropriate access

for authorized staff.



Enabling System-Wide Confidentiality

Settings

Access Organization Preferences

Navigate to System Administration > Organization Settings > Organization Preferences from the side

menu to begin the configuration process.

Locate Security Settings

Click on the "Settings" tab within Organization Preferences to find the confidentiality options

available in the system.

Enable Confidentiality Protection

Check the box for "System: Hide confidential information (case notes and file attachments)

from staff not associated with case/home" to activate the protection.

Save Configuration

Click "Save Settings" at the bottom of the page to apply this system-wide configuration

change and enable the foundation for confidentiality controls.

Once this master setting is enabled, you can begin configuring specific access permissions for individual

users and groups within your organization.



Configuring Individual User Access

Restrictions

Access User Management

Navigate to System Administration > User Management > User ID, then select the specific

user whose permissions need to be restricted.

Locate Permissions Section

Within the user's profile, click on the "Permissions" tab to access the security settings for

that specific user account.

Configure Access Restrictions

Scroll to "Activity/Report Restrictions" and select the specific activities and reports that

should be restricted for this user.

Save User Permissions

Click "Save" at the bottom of the page to apply these restrictions to the user's account

immediately.

Individual user configurations allow you to create custom access profiles that match each staff member's

specific role and responsibilities within your organization.



Setting Up User Group Restrictions

Access User Groups

Navigate to System Administration > User Management >

User Groups, then select an existing group or create a new

one for staff with similar access needs. Configure Group Permissions

Click on the "Permissions" tab within the group profile to

access the security settings that will apply to all members of

this group.Select Restricted Activities

In the "Activity/Report Restrictions" section, check the

boxes for each activity and report type that should be

restricted for all users in this group. Apply and Test Settings

Save the configuration and test the restrictions by logging

in as a group member to verify that the appropriate

restrictions are in place.

User groups streamline administration by allowing you to apply consistent security policies to multiple staff members who share similar roles

and responsibilities.



Granting Access to Confidential Information

Supervisor Override

Grant comprehensive access to supervisors who need to review all case information

Case-Specific Access

Allow access based on direct case association

Basic Access

Provide general access with specific restrictions

For system administrators and supervisors who need full access, enable these two critical permissions in their user profile: "Access confidential

information for all cases" and "Access confidential information for all homes." These permissions override the restrictions and grant complete

visibility across the system while maintaining the protection for other users.



System Testing for Access Controls

Thorough system testing is crucial to validate access control implementations across the extendedReach platform. Employ these

specialized testing methodologies to ensure security integrity: integration testing to verify interactions between system

components, role-based testing to confirm proper permission enforcement, penetration testing to identify potential vulnerabilities,

load testing to assess performance under stress, and regression testing to ensure updates don't compromise existing security

measures. Implementing a comprehensive system testing strategy helps prevent unauthorized access and maintains data

confidentiality throughout the application.



Best Practices for Managing Access Restrictions

Regular Access Audits

Conduct quarterly reviews of

user and group permissions to

ensure they remain

appropriate as staff roles

change within your

organization.

Staff Training

Provide comprehensive

training on confidentiality

policies and the importance of

information security when

onboarding new staff.

Layered Security

Implement multiple security

measures, including access

restrictions, strong password

policies, and two-factor

authentication.

Documentation

Maintain detailed records of

your access control policies

and the rationale behind

specific restrictions for

compliance purposes.

A proactive approach to access management helps maintain the right balance between security and usability, ensuring staff

can efficiently perform their duties while protecting sensitive client information.



Managing Staff Training and

Documentation in

extendedReach

Effective staff training management is critical for foster care agencies to

maintain compliance and ensure quality service delivery. This presentation

will guide you through extendedReach's powerful tools for tracking staff

training and documentation, helping you create standardized processes that

meet regulatory requirements while supporting professional development.
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Overview of Staff Compliance

Tracking

Centralized Documentation

Track all mandatory and optional staff training in one location with automatic

expiration alerts

Regulatory Compliance

Ensure staff meet all required certifications and training hours with

customizable tracking

Role-Based Access

Different permission levels allow administrators to manage records while giving

staff appropriate visibility

Reporting Capabilities

Generate compliance reports to monitor organizational training status and

identify gaps





Configuring the Staff Compliance Checklist

Access Organization Preferences

Navigate to Organization Preferences in the System Administration section

Select Keywords Tab

Click on the Keywords tab and then the Staff sub-tab to access compliance settings

Configure Document and Training Lists

Add required documentation and training items to either Mandated or Other categories

Save Configuration

Click Save to implement your customized compliance checklist for all staff profiles



Setting Up Predetermined Training Parameters

Syntax Format

Use the special format "Training Name|Months Valid|Hours" to standardize

requirements

For example: "CPR|24|2" creates a CPR training that expires after 24 months and

counts as 2 training hours

For documents without training hours: "Background Check|12"

For non-expiring training: "Cultural Diversity|0|3"

Benefits of Predefined Parameters

• Ensures consistency across all staff records

• Prevents data entry errors in expiration dates

• Automatically calculates total training hours

• Simplifies compliance monitoring

• Reduces administrative overhead



Adding New Staff Documents

Access Staff Profile

Navigate to the Staff Directory

and select the staff member's

profile to open their record

Initiate Document
Creation

Click the "Add Document"

button to open the document

creation form

Complete Document

Details

Select a document title from

the dropdown or add a new

type. Enter the expiration date

if applicable and attach

relevant files using the

paperclip icon

Save and Review

Click "Save" to store the

document. The entry will

appear on the Documents tab

and, if mandated, will also

appear on the Compliance tab



Adding New Staff Training Records

Step 1: Access Staff Profile

Navigate to the Staff Directory and click on the name of the staff

member to access their profile

Step 2: Add Training Record

Click the "Add Training" button to open the training creation form

Step 3: Enter Training Details

Select the training topic or add a new one, enter the completion

date, expiration date (if applicable), and training hours. Attach

certificates or other documentation

Step 4: Save and Verify

Click "Save" to store the training record. The entry will appear on

the Training tab and, if mandated, will also show on the

Compliance tab



Staff Access to Compliance Information

System Administrators

Full access to configure, modify, and report on all compliance data

Supervisors

View and manage team compliance status and training records

Staff Members

View personal compliance status and training history

All users can access the "Compliance Tracking" option on the side menu to view relevant compliance information based on their permission level. This data can be exported to Microsoft Excel for further analysis or reporting.



Advanced Staff Training Management

Implementing a comprehensive staff training management system in extendedReach delivers multiple organizational benefits. As

shown in the chart, regulatory compliance represents the largest impact area at 35%, followed by improved staff development at

25% and enhanced risk management at 20%. The system also increases documentation efficiency (15%) and provides valuable

reporting capabilities (5%) for continuous improvement.



Configuring Advanced Staff
Documents and Trainings in

extendedReach

Welcome to our comprehensive guide on enabling and configuring Advanced

Staff Documents and Trainings in extendedReach. This powerful feature allows

case managers and system administrators to build customized training modules

and document templates within the system, significantly improving staff

development tracking and compliance management.

Throughout this presentation, we'll walk through the step-by-step process of

setting up this functionality, explore the various field types available for custom

forms, and provide best practices for implementation. Whether you're new to

extendedReach or looking to enhance your current setup, this guide will help you

optimize your staff training management.

EP
by Emily Parks



Getting Started: Prerequisites

User Permissions

You must have an extendedReach User ID with Full

Administrator permissions to access and configure these

features.

System Access

You'll need access to the System Administration area within

your extendedReach environment.

Planning

Before configuring, identify what types of training documents

and categories your agency needs to track.

Browser Requirements

For best results, use a modern browser like Chrome or Edge

with the extendedReach plugin installed if you'll be working

with Word documents.



Enabling Advanced Staff

Documents and Trainings

Access System Administration

Navigate to the System Administration section through the side menu of

your extendedReach dashboard.

Locate Organization Settings

Find and select the "Organization Settings" option from the administration

menu.

Enable Advanced Features

Within Organization Settings, find the Staff Documents/Training section

and toggle the feature to "Enabled".

Save Configuration

Click the "Save" button to apply your changes. The system will confirm

successful activation.



Understanding Custom Form Field Types

Text Entry Fields

• Single Line Text: For brief

responses

• Paragraph: For longer text entries

• Number: For numerical data only

Selection Fields

• Dropdown: Single selection from a

list

• Checkboxes: Multiple selections

allowed

• Multiple Choice: Radio-button style

selection

Special Fields

• Date & Time: For scheduling

information

• Signature: Electronic signing

capability

• Treatment Goals: Links to client

records

When designing your forms, combine these field types strategically to create intuitive and efficient data collection tools. Consider

the information you need to gather and choose the most appropriate field type for each item.



Building Your First Staff Training Form

Access Form Builder

Navigate to System Administration > Activity Types > Staff Document/Training section to access the form builder interface.

Create New Form

Click "Add New" to create a fresh form template. Provide a descriptive name that clearly identifies its purpose (e.g., "Annual Ethics Training Certification").

Add Form Elements

Use the field type menu to add different elements to your form. Start with section breaks to organize content, then add appropriate fields for data collection.

Configure Options

For each field, set relevant properties such as required status, help text, or predefined options for selection fields.

Save and Test

Save your form and create a test submission to ensure all fields work as expected before deploying it to your staff.



Creating Training Categories for Staff Compliance

Required Certifications

Core qualifications needed for regulatory compliance

Recurring Trainings

Regular refresher courses and updates

Professional Development

Skill enhancement and career growth opportunities

Organizing your staff training into well-defined categories improves tracking efficiency and helps ensure compliance requirements are

met. Create categories that align with both regulatory requirements and your agency's professional development goals. The compliance

tab will automatically track completion rates and approaching deadlines for each category.



Implementing Approval Workflows

Document Submission

Staff member completes and submits

training documentation

Supervisor Review

Supervisor receives notification and

reviews submission

Approval/Rejection

Supervisor approves or requests

corrections

Record Update

System updates compliance records

upon approval

Setting up effective approval workflows ensures quality control and creates accountability in your training process. Configure

notifications to alert supervisors when new submissions require review, and set up automatic compliance updates when

documents receive final approval.



Best Practices & Troubleshooting

Form Design Tips

• Keep forms concise and focused

on essential information

• Use section breaks to organize

content logically

• Include clear instructions for

each field

• Test forms thoroughly before

deployment

Common Issues

• Missing permissions preventing

form access

• Form not appearing in staff

compliance tab

• Required fields not properly

marked

• Signature fields not working on

mobile devices

Ongoing Management

• Review form usage statistics

quarterly

• Update training requirements as

regulations change

• Collect staff feedback on form

usability

• Archive obsolete training

documents



Foster Care Case Referrals

Welcome to the extendedReach Help Center guide on Foster Care Case

Referrals. This comprehensive resource will help you understand how to

manage referrals in the extendedReach system, from creating new referrals

to accepting or denying them, and converting them into cases.
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Introduction to Case Referrals

This article is meant to assist you with Case Referrals.

What are Case Referrals?

Case referrals are potential foster care

placements that your agency receives.

The system allows you to track referred

cases that you accept, reject, or keep in a

pending status.

Why Use the Referral System?

Using the referral system helps your

agency maintain accurate records of all

potential placements, even those you

don't accept, providing valuable data for

reporting and analysis.

How Referrals Work

Referrals may arrive via phone, email,

fax, or electronic transmittal through

extendedReach. The system allows you

to track all information and make informed

decisions.



Referral Screen Layout

Status

Default is Pending – could be "Rejected" or "Accepted". Accepting a referral turns the referral into a case

Program

Program associated with this referral

Funding Organization

The name of the organization paying for foster care services

Funding Case #

Identifier assigned to this case by the funding organization

Referral Source

Where did the referral come from? This list of referral sources starts off empty and is "self-building". As you add new referral sources (using the "+" icon) the referral source will

be added to the drop-down list for subsequent referrals

Referring Worker

Name of the worker who sent the referral to your agency

If the status of the referral is "Pending" and a "Targeted Placement" has been identified, then the name of the pending referral will appear in the left column of the home screen as a

"Targeted Placement".



Your agency has the option of tracking referred cases that you accept, reject, or keep in a pending status. These referrals may arrive via phone, email, fax or electronical transmittal through extendedReach.

If "Referral" is not an option in the menu, you must contact your agency administrator to turn on the "Track Pending and Rejected Referrals" option in "Organization Preferences".



Creating a Referral

Access the Add Menu

Choose "Referral" from the "Add Case" menu

Complete Referral Form

Fill in all required information about the potential case

Save the Referral

The referral will be stored with "Pending" status

Review Available Homes

Use HomeMatch to find appropriate placements

Your agency has the option of tracking referred cases that you accept, reject, or keep in a pending status. These referrals may arrive via phone, email, fax or electronical transmittal through extendedReach.

If "Referral" is not an option in the menu, you must contact your agency administrator to turn on the "Track Pending and Rejected Referrals" option in "Organization Preferences".



HomeMatch Tool

What is HomeMatch?

After you have entered a referral, you can open the referral in

"read" mode where you will see links for available homes on the

left column. This will use our HomeMatch system to search for

homes based on sibling group size, gender, and age.

How to Use HomeMatch

• Open the referral in read mode

• Look for the "Available Homes" section in the left column

• Review the automatically matched homes

• Click on a home to view more details

HomeMatch helps streamline the process of finding appropriate placements for children, saving time and ensuring better matches

between children and foster homes.



Sibling Groups

Assign a Sibling Group ID

Siblings should be grouped by assigning

them a unique "Sibling Group ID". Last

names or court #'s make good sibling ID

#'s. A Sibling Group links profiles, yet

they are maintained separately.

Enter First Sibling Information

Complete all the required information for

the first child in the sibling group.

Add Additional Siblings

To quickly add referrals for a sibling

group, type in a Sibling Group ID then

click "Add Sibling". By clicking on "Add

Sibling", you will automatically save the

profile you have just created.

This will copy much of the referral information and the Sibling Group ID to a new record, making it easier to enter multiple siblings while

maintaining their connection in the system.



Accepting or Denying a Referral

Accepting a Referral

After you have entered your client as a referral, you can choose to accept

the referral by clicking on the tabs at the top of the page. You can then

change the status by clicking on "accept".

Denying a Referral

If you need to deny a referral, click on the "deny" option and select a

reason from the dropdown menu. The "standard list" of denial reasons is

controlled in your Organization Preferences.

If you deny a referral and type a new value not in the standard list (by clicking the "green plus" icon), that denial reason will remain in the drop-down for 6

months since its last usage. To remove non-standard reasons from the drop-down, change the non-standard reasons of denied referrals over the past 6

months to a reason from the standard list.



Opening a Case from a Referral

Review Referral

Ensure all information is accurate and complete

Make Decision

Determine if your agency can accept the client

Open Case

Click on Open Case tab at the top of the screen

Place Client

Assign the client to an appropriate foster home

If you determine you are able to take on a client, you will then open a case by clicking on Open Case tab at the top of the screen. This converts the referral into an active case in your system.



Revert an Open Case to a Referral

Open the case

Navigate to the case you need to revert

Click discharge button

Find the discharge option in the case menu

Select "Move Back to Referral"

Choose this specific option from the discharge menu

If you need to change an open case back to a referral, click on the discharge button and select "Move Back to Referral". This will maintain the documents that have already been completed for

the case.

NOTE:  This option is only available if the case was never placed in a home.

NOTE: If you have denied a referral for a client, don't reopen the referral. Rather, create a new referral with the new date and open that into a case.



Foster Care Case Screen:

General Tab Guide

This comprehensive guide will help you navigate and effectively use the

General Tab in the Foster Care Case Screen within extendedReach. The

General Tab serves as the central location for essential case information,

including client details, funding sources, and educational background. If you

have questions not addressed in this guide, contact support at

support@extendedreach.com.
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General Tab Layout Overview

Tab Structure

The General Tab is organized into several key sections that

contain related information about the foster care case. Each

section is designed to capture specific aspects of the case

management process.

The layout is intuitive, with clearly labeled fields that guide

you through the information entry process. Required fields

are typically marked to ensure all necessary information is

captured.

The General Tab provides a comprehensive overview of the

case, allowing case workers to quickly access and update

essential information without navigating through multiple

screens.



General Tab



Foster Care Case Information

Agency Details

This section includes the agency case number, assigned caseworker, and admission date.

These fields help identify and track the case within your organization's system.

Referral Information

Document the primary and additional referral reasons that brought the child into care. This

information is crucial for understanding the case background and planning appropriate

interventions.

Legal Status

Track important legal dates including TPR (Termination of Parental Rights) petition filing and

when TPR was ordered by the court. These dates are critical for permanency planning.

Organizational Structure

Identify which branch and program within your organization is responsible for the case,

ensuring proper resource allocation and service delivery.



Child Information Section

Personal Identifiers

Record the child's full name, social security number, and other identifying information to

ensure accurate record-keeping.

Demographic Data

Document date of birth, gender, race, and ethnicity information to support appropriate

service planning and cultural considerations.

Status Information

Track additional status indicators that may be relevant to case planning and service

provision for the child.

The Child Information section serves as the demographic foundation for the case record. Accurate and

complete information in this section is essential for proper identification, service planning, and

reporting purposes. This information may also be required for funding and compliance requirements.



Funding Information

Primary Funding Organization

Select the main funding source responsible for covering the costs associated with the child's care.

Secondary Funding

If applicable, identify any additional funding sources that supplement the primary funding.

Rate Level Selection

Choose the appropriate rate level based on the child's needs and the services provided. Rate levels are configured in Program Settings > Program Rate Sheets.

Claims Payer Information

Specify the organization responsible for processing and paying claims related to the child's care.

If you don't see a specific funding organization or claims payer in the dropdown menus, contact support@extendedreach.com for assistance.

mailto:support@extendedreach.com


Education Information

School Enrollment Details

The Education section allows you to document the child's current

educational placement and status. This information is crucial for

ensuring educational stability and appropriate academic support.

Key fields in this section typically include:

• Current school name

• School district

• Grade level

• Enrollment status

• Special education services

• IEP (Individualized Education Plan) status

Maintaining accurate educational information helps case workers

coordinate with schools, advocate for appropriate educational

services, and track academic progress over time.

Regular updates to this section are important, especially when

children change schools or advance to new grade levels.



Employment Information

Employment Status

Indicate whether the youth is currently employed, seeking employment, or not in the

workforce.

Employer Details

Document the name of the employer, position held, and contact information for employment

verification.

Work Schedule

Record the number of hours worked per week and typical schedule to help coordinate other

services and appointments.

Income Information

Track earnings information to support financial planning and independence preparation for

older youth.

The Employment section is particularly important for older youth who are preparing for

independence. Tracking employment history and skills development can support transition planning

and help identify areas where additional support may be needed.



Best Practices for Using the

General Tab for T3C

Regular Updates

Review and update information monthly

Data Accuracy

Verify all information for correctness

Cross-Reference

Ensure consistency across all tabs

Team Communication

Share updates with all team members

The General Tab serves as the foundation for case management in extendedReach. Maintaining accurate and up-to-date information in this tab ensures that all team members have

access to the essential details they need to provide effective services. Remember that information entered here may flow to other parts of the system, including reports and billing

documentation, making accuracy particularly important. The General Tab holds many tools for tracking T3C requirements.

For more detailed information about other tabs in the Case Screen, refer to the related articles about the Financial Tab, Health Tab, People Tab, and other components of the

extendedReach system.



Understanding the Health Tab
in Foster Care Case
Management

Welcome to our comprehensive guide for managing client health

information in the Foster Care Case Management system. This

presentation will walk you through the essential features of the Health Tab's

Summary section, equipping you with the knowledge to efficiently track and

manage critical medical information for children in care.

We'll explore how to access medical contacts, track appointment dates,

document chronic health conditions, and maintain a detailed physical

inventory. By mastering these features, you'll ensure comprehensive health

monitoring and improve continuity of care for the children you serve.
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Navigating the Health Tab Summary Layout

Access the Summary

Navigate to the Case Screen and select the Health tab, then click on the Summary

section

Review Medical Information

View organized sections for medical contacts, appointments, and health conditions

Update Health Data

Enter or modify information in each section as needed to maintain current records

Track History

Monitor changes and updates to maintain a comprehensive health history

The Summary section serves as your central hub for all health-related information. Its intuitive layout organizes crucial details into clearly defined sections, allowing you to quickly access and

update vital medical information for children in your care.



Managing Medical Contacts

Quick Access to Provider Information

The Medical Contacts section displays all

healthcare providers associated with the child,

including doctors, specialists, and therapists.

Each name is hyperlinked for convenient

access to their complete information.

Seamless Navigation to Details

Simply click on any blue, hyperlinked provider

name to be instantly directed to their detailed

information in the People tab, eliminating the

need to navigate through multiple screens.

Comprehensive Provider Overview

This centralized listing helps ensure all team

members are aware of the child's complete

medical network, improving coordination of care

and communication between providers.

Maintaining accurate medical contact information is crucial for coordinating care. This section gives you instant visibility into all healthcare providers involved in the

child's treatment, allowing for better communication and more coordinated care planning.



Tracking Medical Appointments

View Appointments

See all completed and upcoming medical

appointments in a comprehensive timeline

Access Details

Click on any blue hyperlinked date to view complete

appointment information

Add Comments

Document important observations or follow-up

requirements after each visit

Monitor Compliance

Track whether all required medical appointments are

being completed on schedule

The Medical Appointment Dates section provides a chronological overview of all healthcare interactions. This helps you ensure that children receive timely medical care and that all required appointments are scheduled and

completed according to care plans and regulations.

Remember that appointments are added through their associated program activity, but can be viewed and tracked comprehensively in this section. This integration ensures all health information remains connected to the broader case

management system.



Documenting Chronic Health Conditions

Condition Documentation

Enter detailed information about each chronic health

condition, including diagnosis date, treating

physician, and current status.

This documentation ensures all caregivers and

service providers have accurate information about

ongoing health needs.

Treatment Tracking

Record medications, therapies, and other

interventions prescribed for each condition.

Monitoring treatment plans in one location helps

ensure consistency of care across different settings

and caregivers.

No Conditions Option

If the client has no known chronic health conditions,

simply check the "No known chronic health

conditions" box.

This positive confirmation helps distinguish between

"none known" and "not yet documented" situations.

Accurate documentation of chronic health conditions is essential for providing appropriate care. This section allows you to maintain a comprehensive record of all ongoing

health issues, ensuring that caregivers, medical providers, and other team members have the information they need to support the child's wellbeing.



Maintaining the Physical Inventory

Physical Attributes

Record eye color, hair color, and vision needs

Growth Tracking

Document height and weight measurements

Distinctive Features

Note birthmarks, scars, or other identifying marks

Development Monitoring

Track physical changes over time

The Physical Inventory section allows you to maintain detailed records of a child's physical characteristics and changes over time. This information serves multiple purposes, from helping identify a child in an emergency to tracking

healthy growth and development patterns.

Regular updates to this section create a valuable longitudinal record that can help medical providers identify potential health concerns early. It also provides important continuity of information as children move between placements or

transition to different case workers.



Best Practices for Health Documentation

Update Information Promptly

Enter new medical information within 24 hours of

receiving it to ensure records are always current and

accurate

Verify Data Accuracy

Double-check all entered information and cross-

reference with medical reports when available

Connect Related Information

Ensure appointments, conditions, and treatments are

properly linked in the system

Maintain Confidentiality

Follow all privacy protocols when documenting

sensitive health information

Implementing consistent documentation practices ensures that health information remains reliable and useful. When all team

members follow these guidelines, the Health Tab becomes an invaluable tool for coordinating care and making informed

decisions about a child's wellbeing.

Remember that thorough health documentation also fulfills important compliance requirements and creates a valuable historical

record that stays with the child throughout their time in care.



Getting Additional Support

Email Support

Contact the support team at

support@extendedreach.com

for assistance with any

questions not covered in this

guide.

Documentation

Access comprehensive user

guides and documentation

through the Help Center for

detailed instructions on all

system features.

Training Resources

Take advantage of training

videos and webinars

designed to help you master

the Health Tab and other

system components.

Peer Knowledge

Connect with experienced

colleagues who can share

best practices and workflow

tips for efficient health

information management.

Our dedicated support team is always ready to assist you with any questions or challenges you may encounter while using the

Health Tab. We're committed to ensuring you have the resources and knowledge needed to effectively manage health

information for the children in your care.

Remember that your feedback is valuable in helping us improve the system. If you have suggestions for enhancements or

additional features, please share them with our support team.

mailto:support@extendedreach.com


Navigating the Behavioral

Health Tab in ExtendedReach

Welcome to our comprehensive guide to the Behavioral portion of the Health Tab in

the Case Screen. This essential feature allows you to document critical behavioral

health information for foster children in your care.

We'll walk you through each component of this interface, demonstrating how to

properly record psychological diagnoses, intelligence assessment data, and

personal attributes that help create a holistic view of each child. Understanding how

to navigate and utilize this tab effectively will strengthen your case management

and improve outcomes for the children you serve.

If you encounter questions not addressed in this guide, contact our support team at

support@extendedreach.com.
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Understanding the Behavioral Tab Layout

Access the Tab

Navigate to the Case Screen and select the Health tab. From there, click on the

Behavioral sub-tab to access all behavioral health documentation features.

Psychological Section

Document all formal diagnoses using DSM codes and criteria. This section includes

diagnosis dates, review information, and supporting comments.
Intelligence Data

Record IQ testing results, including most recent and highest scores with corresponding

dates for tracking cognitive development.
Personal Attributes

Document hobbies, interests, and strengths to develop a well-rounded understanding of

the child beyond clinical assessments.

The Behavioral tab serves as a centralized location for all behavioral health information, allowing case workers to track changes over time and ensure appropriate services are being provided to meet

each child's unique needs.



Recording Psychological Diagnoses

Search by DSM Code

Begin by searching the diagnosis field using the DSM code number. The system will display matching diagnoses from which you can select.

Enter Review Date

Document when the diagnosis was initially reviewed using the calendar selector to ensure accurate tracking of assessment timelines.

Identify Reviewer

Enter the name of the professional who reviewed the diagnosis in the "Diagnosis Reviewed By" field for accountability and follow-up.

Add Additional Diagnoses

After entering the primary diagnosis, the system automatically adds fields for additional diagnoses. Enter all relevant conditions to ensure

comprehensive care.

Accurate diagnosis documentation is critical for developing appropriate treatment plans and securing necessary services. Always verify that diagnostic

information is current and has been properly reviewed by qualified professionals.



Adding Diagnostic Comments

Context and History

Include information about when symptoms first appeared, how they've

evolved over time, and any triggering events that may have contributed to

the diagnosis.

Treatment Response

Document how the child has responded to previous or current treatments,

including therapy approaches, interventions, and medications that have

been tried.

Functional Impact

Note how the diagnosis affects daily functioning, including school

performance, social relationships, and ability to participate in age-

appropriate activities.

Diagnostic Uncertainty

Record any disagreement among providers about the diagnosis or notes

about symptoms that don't fully align with diagnostic criteria that may need

further assessment.

The comments section provides critical context beyond the formal diagnosis code. Detailed notes help the care team understand the unique presentation of

symptoms in this child and can highlight areas requiring specialized intervention or additional support services.



Tracking Intelligence Quotient Data

Field Name Description Best Practices

Last IQ Score Most recent IQ assessment result Include full-scale score and date of assessment

Last Score Date When the most recent assessment occurred Update after each new evaluation

Highest Known IQ Score Highest recorded score from any assessment May differ from most recent; important for tracking

potential

Highest Score Date When the highest score was achieved Helps identify timing of optimal performance

IQ testing provides valuable information about a child's cognitive abilities and learning needs. These assessments should be interpreted as one piece of a larger picture,

rather than definitive measures of intelligence or potential.

When significant discrepancies exist between test scores, consider factors such as testing conditions, the child's emotional state during assessment, or developmental

changes that may explain the variation.



Documenting Hobbies and Interests

Creative Activities

Document artistic interests such as drawing, painting, music, dance, or

creative writing that the child enjoys or shows aptitude for.

Physical Activities

Record participation in sports, outdoor activities, or exercise preferences

that promote physical health and social development.

Intellectual Pursuits

Note interests in reading, specific academic subjects, puzzles, strategy

games, or other activities that engage cognitive skills.

Social Interests

Capture preferred social activities, clubs, community involvement, or

specific relationship patterns that reveal social preferences.

Understanding a child's interests provides insight into potential motivational tools and therapeutic approaches. This information helps create more personalized treatment

plans and identifies activities that can build self-esteem and create opportunities for positive reinforcement.

Regularly update this section as interests evolve, and use this information when coordinating with schools, therapists, and foster families to ensure consistency in

supporting the child's development.



Identifying and Recording Strengths

Character Strengths

Virtues like honesty, perseverance, compassion, and courage

Interpersonal Strengths

Skills in communication, leadership, conflict resolution, and empathy

Practical Strengths

Abilities like organization, problem-solving, and self-care skills

Achievement Strengths

Areas of academic, athletic, artistic, or other demonstrated competence

Identifying a child's strengths is fundamental to strengths-based case management. These positive attributes can be leveraged in treatment planning and placement decisions to

build resilience and promote positive development despite adverse experiences.

Documenting strengths helps counter the deficit-focused nature of much clinical documentation and ensures that the child is seen as a whole person with capabilities and

potential, not just as a collection of problems to be solved.



Best Practices for Documentation

Regular Updates

Update behavioral information at least

quarterly or whenever significant changes

occur to maintain current records.

Comprehensive Documentation

Include information from multiple sources

such as therapists, teachers, foster parents,

and the child themselves.

Objective Language

Use clear, factual descriptions avoiding

subjective judgments or stigmatizing

terminology.

Connect to Services

Ensure documented needs directly inform

service planning and are reflected in the

child's care plan.

Thorough documentation in the Behavioral tab provides valuable insights for the entire care team. This information helps ensure continuity of care

across placements, informs educational planning, and supports advocacy efforts for appropriate services.

Remember that this documentation becomes part of the child's permanent record. Focus on capturing information that will be helpful for

understanding the child's needs and strengths both now and in the future as they transition through the foster care system.



Comprehensive Guide to
Medication Administration
Record (MAR) Subforms

Welcome to our comprehensive guide on Medication Administration Record (MAR)

subforms. This presentation will provide you with detailed information about the

various MAR subforms available in extendedReach, their specific fields, and how to

implement them correctly in your documentation workflow.

As internal staff responsible for medication administration and documentation,

understanding these subforms is crucial for maintaining accurate records, ensuring

proper medication delivery, and meeting compliance requirements. Let's explore the

tools available to streamline your medication documentation process.
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System Access Requirements & Implementation
Process

Required Permissions

Access to MAR subforms requires

either Full Administrator privileges

or Restricted Administrator - Forms

Administration permissions in

extendedReach.

Locating Subforms

Find specific subforms by scrolling

through the comprehensive list or

using browser search functionality

(CTRL+F) to quickly locate the

required form type.

Implementation Steps

After identifying the appropriate

subform, copy the exact name and

add it to a program report type

specifically configured for MAR

documentation.



Internal MAR Subform: S_Case_MAR Overview

Core Functionality

This standard internal MAR subform pulls medications 1-15 from the medications tab in the Health

section of case files. It provides basic medication tracking functionality with simplified status options.

Key Features

• Monthly organization with days 1-31 tracking grid

• Core medication details including name, dosage, and prescriber

• Four medication status options for clear documentation

Status Options

• Medication Given

• Medication Not Given

• Client Refused

• See Notes



Advanced Internal MAR Options: S_Case_MAR_DDM & S_Case_MAR_CF

S_Case_MAR_DDM Series

Enhanced tracking for medications 1-13 (standard) and 14-26 (extended version). Includes detailed status options

for precise documentation of medication events, plus additional fields for prescription numbers and refill tracking.

S_Case_MAR_CF Series

Comprehensive tracking with expanded status options for residential care scenarios. Includes specialized codes for

situations like home visits, school administration, and hospitalizations. Available in standard (1-13) and extended

(14-26) versions.

Incident Reporting Integration

Both advanced form series include status codes that automatically trigger incident report requirements, creating

accountability for missed doses and documentation of medication refusals.



Foster Family Website MAR Subforms: Basic Options

F_FRM_MAR

Standard foster family form tracking

medications 1-15 with expanded

administration options specifying who

administered the medication (EBP, EEP, or

Other). Includes client identification fields

and full month tracking grid.

F_FRM_MAR_15_30

Extended medication tracking for

medications 16-30, enabling documentation

of complex medication regimens. Includes

simplified administration options while

maintaining comprehensive tracking

capability.

F_FRM_MARS Series

Enhanced accountability through electronic

signature requirements. Available in three

variations with different signature

configurations: single signature,

parent/child signatures, or dual parent

signatures.



Foster Family Website MAR Subforms: Specialized Options

Number of Status Options Max Medications Tracked

The F_FRM_MAR_CC subform stands out with its unique "Medication Given at School" status option, making it particularly valuable for school-age children. It also features a "See Notes - Fill All Days" option that streamlines documentation for

consistent medication scenarios.

The F_FRM_MARPC series offers expanded medication tracking capacity, supporting documentation of up to 39 different medications through its three sequential forms. These forms include pill count/doses fields for inventory management and

enhanced accountability, making them ideal for complex medication regimens.



Selecting the Right MAR Subform for Your Documentation Needs

Consider Your Environment

Internal staff vs. foster family implementation

Assess Medication Complexity

Number of medications and administration frequency

Determine Accountability Needs

Signature requirements and status tracking detail

Evaluate Reporting Requirements

Integration with incident reporting and documentation detail

When selecting the appropriate MAR subform, begin by considering your specific practice environment and whether the form will be used internally or by foster families.

Next, evaluate the complexity of medication regimens you typically manage, as this will determine if you need extended medication capacity.

Accountability requirements should guide your decision regarding signature fields and status tracking options. Finally, consider how your documentation needs to

integrate with incident reporting systems and what level of detail is required for compliance and quality assurance purposes.



Implementation Best Practices & Key Takeaways

Standardize Form Selection

Establish clear guidelines for which MAR subforms should be used in specific situations to ensure consistency across your organization.

Provide Comprehensive Training

Ensure all staff and foster families understand how to properly complete their designated MAR subforms, including proper use of status codes and

documentation requirements.

Implement Regular Audits

Establish a system for reviewing completed MARs to identify documentation gaps or training needs and ensure medication administration

compliance.

Develop Support Resources

Create quick reference guides for each MAR subform type to help users select the appropriate codes and complete documentation accurately.

Remember that MAR subforms cannot be customized with additional fields or modifications. This standardization ensures data integrity and system compatibility. If

you encounter specific documentation needs not addressed by the available subforms, consider supplementing with additional documentation rather than

attempting to modify the MAR structure.



Foster Care Compliance Tab:

Complete User Guide

The Compliance Tab within foster care case management provides a

comprehensive overview of activities and reports that have been collected,

are missing, or are due. This essential tool helps caseworkers maintain

regulatory compliance and track critical documentation efficiently.

This guide will walk you through every aspect of the Compliance Tab, from

understanding color-coded status indicators to filtering and exporting

compliance data across multiple cases.
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Understanding the Compliance Tab Purpose

High-Level Overview

Provides a quick glance at all case

activities and reports in one

centralized location

Current Status Focus

Shows only the most recent

document for each item,

streamlining case review

Historical Access

For previous versions of

documents like Service Plans,

users must refer to the Case File

Tab



Color-Coded Status System

Green Status

Item has been completed OR item is due or expires more than 10 days from now.

This indicates good standing and no immediate action required.

Red Status

Item is missing, past due, or has expired. This requires immediate attention and

action from the caseworker.

Yellow Status

Item is currently drafted/in progress or expires within the next 10 days. This serves

as an early warning system.

White Status

Optional items that appear only when "Show Hidden, Optional Items" is clicked.

These become tracked once documents are added.



Optional Items Management

Hidden by Default

Optional items remain invisible in

normal view

Click to Reveal

Use "Show Hidden, Optional Items"

button

Automatic Tracking

Adding documents activates

compliance monitoring



Compliance Categories Structure

Admission/Intake

Initial case documentation and entry requirements

1

Casework

Ongoing case management activities and reports

2

Medical/Dental

Health-related documentation and appointments
3

Legal

Court orders, legal documents, and compliance items

4

Behavioral

Behavioral assessments and intervention plans

5

Discharge

Case closure and transition documentation
6



Category Customization

Options

1 Agency Administrator Access

Only administrators can modify compliance categories through

Program Settings

2 Setup Tab Navigation

Categories are managed under the Setup tab in Program

Settings

3 Alphabetical Organization

All items within each category are automatically listed

alphabetically



Accessing Activities and
Reports

Blue Hyperlink Access

Click on the blue hyperlink next to any Activity or Report to access the

current version of that document directly.

Direct Navigation

This provides immediate access to the most recent version of any

compliance item for quick review or editing.

Streamlined Workflow

The hyperlink system eliminates the need to navigate through

multiple screens to find specific documents.



Managing Previous Versions

Three Dots Menu

Click on the three dots to the right of each entry to access a dropdown menu with additional

options for that compliance item.

This menu provides access to historical versions and the ability to add new reports when

needed.

Add New Reports

For items that don't expire or have repeating due dates, select "Add Report" from the three

dots menu to create new versions.

This feature is essential for ongoing documentation requirements that need regular updates.



Expiration Date Management

1

Direct Linking

Items with expiration dates link directly to new versions

2
Automatic Renewal

System recognizes when items need updating based on dates

3
Due Date Tracking

Comprehensive monitoring of all time-sensitive compliance items



Accessing Compliance

Tracking

Navigate to Workspace

Start from your main Workspace and locate the "Cases"

section on the left side of your screen

Hover Over Case Tasks

Move your cursor over "Case Tasks" to reveal the dropdown

menu with additional options

Select Compliance Tracking

Click on "Compliance Tracking" to access a comprehensive

snapshot of compliance status across all your cases



Filtering by Program

Program Filter

Click on the Program Box at the top of the screen to filter compliance data by specific programs

Caseworker Filter

Use the Caseworker Box to filter and view compliance status for specific workers

Scroll Selection

Scroll through available options and click to select your desired filter criteria



Exporting Compliance Data

Excel Export

Click "Excel" at the top of the screen

to export compliance information

1
Microsoft Word Excel

Data exports into a Microsoft Word

Excel spreadsheet format
2

Comprehensive Data

Export includes all filtered compliance

tracking information

3

External Analysis

Exported data can be used for further

analysis and reporting

4



Support and Additional Resources

Technical Support

For questions not addressed in this guide, contact support at

support@extendedreach.com. The support team is available

to help with technical issues and provide additional guidance

on using the Compliance Tab effectively.

Sales Inquiries

For advanced reporting features and platform enhancements,

reach out to sales@extendedreach.com. They can discuss

adding Zoho Analytics Reports and other premium features to

expand your compliance tracking capabilities.



Key Takeaways and Best
Practices

Color-Coded Efficiency

Use the color-coding system to quickly identify items requiring immediate attention

(red), upcoming deadlines (yellow), and completed items (green)

Regular Monitoring

Check the Compliance Tab regularly to stay ahead of due dates and maintain

regulatory compliance across all cases

Utilize Filtering

Take advantage of program and caseworker filtering to focus on specific areas and

export relevant data for analysis and reporting

Leverage Support

Don't hesitate to contact support for technical assistance or sales for advanced

reporting capabilities to maximize your compliance tracking efficiency



Daily Activity and Report

Summary: Simplifying Task

Management

Welcome to our comprehensive guide on configuring and utilizing the Daily

Activity and Report Summary feature. This powerful tracking tool helps

system administrators visualize completed, missing, or duplicated activities

and reports for both cases and homes in the ExtendedReach platform.

Throughout this presentation, we'll walk through the complete setup process,

from enabling system preferences to interpreting the color-coded tracking

interface. By implementing this feature, your team can better monitor daily

tasks, improve accountability, and ensure consistent documentation across

your organization.
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System Configuration: Enabling Activity

Tracking

Access Organization Settings

Navigate to Organization Settings > Organization Preferences > Settings to begin configuration

Enable System Tracking

Activate both "System: Track daily activities for cases" and "System: Track daily activities for

homes" options

Configure User Permissions

For each staff member, enable "Show Case Daily Activity Summary" or "Show Home

Daily Activity Summary" on their User ID

The system configuration requires administrator access to establish organization-wide settings.

Once enabled at the system level, administrators must then set individual user permissions to

determine which staff members can access the daily summary features. Staff with House Parent

workplace roles will automatically see activities for all assigned cases and homes.



User Permission Management

Administrator Tasks

As a system administrator, you'll need to configure user-specific

permissions after enabling system tracking. Navigate to

Organization Settings > User IDs to access individual staff settings.

Look for the permissions section where you can enable either

"Show Case Daily Activity Summary on workspace" or "Show Home

Daily Activity Summary on workspace" depending on staff

responsibilities. The permission settings displayed in the User ID configuration panel

determine which staff members can view daily activity summaries.

This granular control ensures that staff only see relevant information

based on their roles and responsibilities.

Remember that staff members will only see the daily activities for cases and homes specifically assigned to them, and only when they've

selected the House Parent workplace role. This helps maintain appropriate access controls while providing necessary visibility to those who

need it.



Configuring Daily Activities

Access Activity Settings

Navigate to the program or home activity you want to track daily

Select Tracking Schedule

Choose either "Daily activity (completed Sun-Sat)" or "Daily Activity (completed

Mon-Fri)"

Review Configuration

Confirm settings - note that due/expiration dates will be removed

Configure Additional Activities

Repeat process for all activities you wish to track daily

When configuring activities for daily tracking, it's important to note that the system will

automatically remove due/expiration dates. This is by design, as repeating daily due dates would

quickly overwhelm task lists and become unmanageable. Instead, the daily activity summary

provides a more streamlined approach to monitoring recurring tasks.



Setting Up Report Tracking

Access Report Settings

Navigate to program report or home report settings for the

reports you want to track on a daily basis. These settings are

accessible through the administrative interface.

Select Tracking Frequency

Choose between "Daily activity (completed Sun-Sat)" for full

week tracking or "Daily Activity (completed Mon-Fri)" for

weekday-only tracking, depending on your organization's

operational schedule.

Apply Configuration

Save your settings to begin tracking the selected reports. The

configuration process is nearly identical to setting up daily

activities, maintaining consistency in the administrative

experience.

Report tracking follows the same configuration principles as activity tracking, but applies specifically to documentation requirements. By implementing both activity and report tracking, administrators can create a

comprehensive daily monitoring system that covers all aspects of required case and home management tasks.



Accessing the Daily Summary

Case Tasks Method

Navigate to Case Tasks > Daily Activity Summary to view case-related activities

Home Tasks Method

Navigate to Home Tasks > Daily Activity Summary to view home-related activities

Workspace Method

Click on hyperlinks under My Summary section for quick access from workspace

Case/Home File Method

Access through the Case File/Home File tab to view current and previous week's

summaries

The system provides multiple navigation paths to access daily summaries, accommodating different

workflows. Staff can choose the most convenient access method based on their current location in

the system and the specific information they need to review. The workspace view offers particularly

quick access for routine daily checks.



Understanding the Color-Coded Interface

Green

Activity or report has been successfully

completed

1
Yellow

Duplicate activity or report has been

completed

Red

Activity or report exists as a draft but hasn't

been completed

White

Activity or report has not been created yet

The color-coded visual system provides an intuitive way to quickly assess task status across cases and homes. Each dot

represents an activity or report for a specific day, with colors indicating completion status. This at-a-glance visualization helps

administrators and staff identify gaps or issues requiring attention without reviewing individual records.



Maximizing Daily Summary Functionality

Interactive Navigation

Click directly on colored dots to access the corresponding activity or report for immediate review or editing

Quick Creation

Click on white dots to create new activities or reports for days where none exist

Historical Review

Access previous week's summaries through the Case/Home File tab for retrospective analysis

Compliance Monitoring

Use the visual patterns to identify recurring documentation gaps or issues requiring intervention

Beyond basic status tracking, the Daily Activity Summary serves as a powerful navigation and workflow tool. The interactive interface allows staff to quickly access, create, and manage activities and reports directly from the summary

view. For administrators, the summary provides valuable compliance insights, helping identify patterns that may indicate training needs or process improvements.

If you have questions not addressed in this presentation, please contact support at support@extendedreach.com for additional assistance with configuring or using the Daily Activity and Report Summary feature.



Foster Care - Case Screen: People Tab

This presentation will guide you through the People Tab in a Case Screen. The People Tab is a great place to store information,

as this data will be accessible to all users within your agency.

We'll cover the following topics:

• Introduction

• People Tab Layout

• Add Relationship

• Copy From Other Case

• Copy from Address Book

• Sibling Group

EP
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Introduction

Purpose

This article is meant to assist you with the People Tab in a Case

Screen. The People Tab is a great place to store information, as this

data will be accessible to all users within your agency.

Support

If you have a question not addressed here, you can contact support

at support@extendedreach.com.

mailto:support@extendedreach.com


People Tab Layout

Overview

The People tab is where you can enter in

information about the People involved int

he client's life. Biological parents, aunts,

uncles, grandparents, medical

professionals, etc.

Adding Methods

There are 3 methods that can be used

when adding people to the People tab:

manually adding the relationship, copying

relationships from other cases, or

copying from the address book.

Data Access

This data will be accessible to all users

within your agency, making it a central

repository for important relationship

information.



Add Relationship

Click "Add Relationship"

To add a relationship to the extendedReach system specific to the client, click on "Add Relationship".

Select Relationship Type

Use the "Type" drop-down to select whether the relationship type is for a person or an organization. Depending on what you select in the "Type" drop-down, your options for the "Relationship" field

will vary.

Specify Custom Relationships

If the relationship you are looking for is unavailable in the Relationship field, select "Other" and indicate the relationship type in the "Specify" field.

Set Additional Options

Additionally, indicate whether or not the individual is an approved visitor and if they are approved for phone calls. You can flag the relationship, which will show in the main People tab view.



Copy from Other Case

Click "Copy from Other

Case"

Another way to add a relationship

to the People Tab, is to click on

"Copy from Other Case".

Select Source Case

A pop-up will then appear that will

allow you to pick a case to pull

relationships from.

Choose Relationships

You can pick select relationships

or click on Check All and then Ok

to transfer the relationships over.



Copy from Address Book

Address Book Integration

The last way to add a relationship to the People Tab, is to click on "Copy from Address Book".

This will pull all the information over for the selected individuals from the agency's extendedReach address

book.

Benefits

• Saves time by reusing existing contact information

• Ensures consistency across the system

• Reduces data entry errors

• Maintains up-to-date contact information

https://er1.extendedreach.org/hc/en-us/articles/15096654882075-Address-Book
https://er1.extendedreach.org/hc/en-us/articles/15096654882075-Address-Book


Sibling Group

Create Sibling Group ID

Link together siblings by creating a Sibling Group ID.

View Linked Siblings

Once the ID has been created, linked siblings will show in the

Sibling Group section on the People tab.

Share Information

Reports and activities can be configured to copy over to siblings

to prevent repetitive entry.

Find Existing Groups

Use the magnifying glass to search for a Sibling Group ID that

has already been created. Click on the ID and then Save on the

case profile and the link will be created.

If there are siblings not in care at the agency, add the siblings as a relationship under the People tab.



Foster Care - Case Screen:

Case File Tab

This guide will assist you with the Case File Tab in a Case Screen. The

content covers Introduction, Case File, Show options, and how to

Download Files.
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Introduction

Purpose

This article is meant to assist you with the Case File Tab in

a Case Screen.

Support

If you have a question not addressed here, you can contact

support at support@extendedreach.com.

mailto:support@extendedreach.com


Case File Tab Layout

The Case File view allows you to view all completed, due, drafted, or expiring reports and activities. Additionally, you can view any case revision history, placement history, and more!

Image: "Case Screen: Case File Tab Layout"

Use the "Show" drop-down to select what you want to view in the Case File.

Image: "Show Case Records Options"

Field Name Description

Activities Displays a list of all due and completed activities for the client

Required Activities Displays a list of all due and completed required activities for the client

Daily Activities View all daily activities completed or coming due

Case Notes Displays a list of all case notes for the client

Expenses Displays a list of all of the incurred expenses for the client

Medical Displays a list of all medical due/completed dates for the client

Medical Case Notes Displays a list of all medical case notes for the client

Placements Displays a list of all placement history for the client

Placements + Rates Displays a list of all placement and rate changes for the client

Reports Displays a list of all due and completed reports for the client

Revisions Displays a list of all revisions made for the client

Tests Displays a list of all due and completed tests for the client

Audit Log Shows all recent activity in the case, including who has accessed it, edited it, or created any items

Recently Deleted Lists all items that have been deleted from the case profile in 90 days

https://er1.extendedreach.org/hc/en-us/articles/15084829897627-Daily-Activity-and-Report-Summary


Download Files

Access Download Option

You can download all of the files available in the Case File directly to your computer in a zip folder.

Choose Download Period

You can choose to either download all files or all files in the last 45 days.

Access Downloaded Files

Once downloaded, you will be able to access a folder with all the home documentation, in chronological order.

Image: "Download Files Option"

Image: "Downloads"



Managing Treatment Goals in Foster Care Case Management

The Treatment tab in extendedReach provides a comprehensive way to track a child's educational, social, medical, and other developmental goals within the foster care system. This powerful feature allows case managers to document objectives, monitor

progress, establish timeframes, and record specific interventions needed for goal achievement.

Setting Up the Treatment Tab

Before using this feature, system administrators must enable it through Program Settings. Navigate to Program Settings >

Programs > Select program > Setup and check "Treatment: Track treatment goals" to activate this functionality for your

agency.

Additional customization options are available under Organization Settings > Organization Preferences > Settings > Show

Advanced Settings, where you can add goal categories, customize statuses, and modify field labels to match your agency's

terminology.

The Treatment tab provides a clear overview of all goals with options to filter by active status. Adding new goals can be done

manually for individual cases or by copying existing goals from other cases to maintain consistency in documentation.

Goal Documentation

Record specific objectives with detailed descriptions of desired outcomes and timeframes for achievement

Intervention Planning

Document actions and strategies that will be implemented to help the child reach their goals

Progress Tracking

Monitor and record advancement toward goals with status indicators (in process, achieved, not achieved)

Reporting

Generate comprehensive reports showing goal achievement percentages and outcomes across categories

The Treatment Goals report under Casework > Treatment Goals provides valuable insights into goal progress with percentage breakdowns by status. Using the Group By feature allows for organization by caseworker or goal category, facilitating effective

supervision and program evaluation.

EP by Emily Parks



Turning on Treatment Goals

Can also rename this Tab



Choose what to track



View Status Updates Anytime



Wording and Dropdowns Configurable



Treatment Goal Reporting



Foster Care - Case Screen:

Financial Tab

This presentation covers the Financial Tab in the Foster Care Case

Screen, including its layout and key components: Charge, Payment,

Adjustment, Authorization, and Account Balance. The Financial Tab is

only available with the Enterprise Financials add-on.

EP
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Financial Tab Layout

Overview

The Financial tab will provide an overview of all payments,

charges, adjustments, and authorizations for a case.

Filtering Options

Use the "Show" drop-down to filter what items display in the

Financial Activity screen.

Default Display

By default, it will display all open items.



Introduction

Purpose

This article is meant to assist

you with the Financial Tab in

a Case Screen. The Financial

Tab is only available with the

Enterprise Financials add-on.

Additional Information

For more information or a

demo, please contact

sales@extendedreach.com.

Support

If you have a question not addressed here, you can contact support

at support@extendedreach.com.

https://er1.extendedreach.org/hc/en-us/articles/15305293253147-Enterprise-Financials-Overview
https://er1.extendedreach.org/hc/en-us/articles/15305293253147-Enterprise-Financials-Overview
mailto:sales@extendedreach.com
mailto:support@extendedreach.com


Charge

Purpose

Charges are mainly used for Days Care; however, charges can also be used for

clothing, allowances, transportation, etc.

Creation

To create a new charge, click on Charge.

Automation

Days Care charges should be generated automatically and can be done so using the

Days Care: AR Generation (Organization Billing > Days Care: AR Generation >

Generate AR).

Completion

Complete the required fields and then click Save. If you have multiple entries, click

Add Another.

The Charge screen includes fields for Charge Date, Type, Home Name, Amount, Memo, Status, Bill

To, Reimburse home, and Specify quantity and rate options. Additional options are available in the

Billing tab for posting charges and entering adjusted debits and credits.

https://er1.extendedreach.org/hc/en-us/articles/15301304344987-Days-Care-Billing-Generation
https://er1.extendedreach.org/hc/en-us/articles/15301304344987-Days-Care-Billing-Generation
https://er1.extendedreach.org/hc/en-us/articles/15301304344987-Days-Care-Billing-Generation
https://er1.extendedreach.org/hc/en-us/articles/15301304344987-Days-Care-Billing-Generation


Payment

Field Name Description

Payment Date Date of the payment

Type Select the payment type from the drop-down menu

Check Number Enter in the check number in this field

Amount Enter in the amount of payment received

Memo Specify details about the charge

Deposit Date Indicate the date the payment was deposited

Status Displays the status of the payment

Payment From Use the drop-down menu to indicate who the payment was from

To add a payment that has been received to the extendedReach system, click on "Payment". Complete the required fields highlighted in yellow before applying the payment. By checking the box next to a charge, the eR system will calculate your payment. Payments need to

be applied to charges in order to zero out any balances.



Adjustment

Purpose

Adjustments are mainly used to correct Days Care charges, either for the

wrong rate or wrong placement dates; however, can be used to correct

other case charges as well.

Creation

To add an adjustment to the extendedReach system, click on

"Adjustment".

Completion

Complete the highlighted fields and "Save". If Days Care is being

adjusted, select the Days Care charge to apply the adjustment to and

enter in the amount to add to the Days Care charge (Days Care Increase)

or the amount to remove from the Days Care charge (Days Care

Decrease).

Field information includes Adjustment Date, Adjustment type, Type selection, Apply To

field, Amount, Memo, and Status indicators.



Authorization

Purpose

If an authorization (or prior approval) has been granted by an insurance

company to keep track of billable activities, click on Authorization to add the

information.

Creation Process

Complete the highlighted fields and "Save". Indicate the Authorization

Type the authorization can be used for and who it is from.

Management

If the authorization is no longer being used, click on the box next to

"Inactive". Once saved, authorizations can be applied to their specified

types in future charges.



Account Balance

Location

The account balance will appear at the bottom of the Financial tab.

Additional Information

Additional aging account information can be found under the Financial tab on the Summaries menu > Aging Report.

Purpose

Provides a quick overview of the current financial status of the case.



Tracking Adoption Cases
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Introduction to Tracking
Adoption Cases

This article is meant to provide workers with an overview of tracking adoption

cases in extendedReach. If you have a question not addressed here, you can

contact support at support@extendedreach.com.

Purpose

Provide comprehensive

guidance on tracking adoption

cases in the extendedReach

system

Audience

Case workers and staff

managing adoption processes

Support

Contact support@extendedreach.com for additional questions

mailto:support@extendedreach.com


Adoption Case Information

This section will appear for foster-adopt and straight adoption cases.

Image: "Adoption Case Information"

Field Name Description

Adoption Admission Select a date with the calendar icon on the right side of the information box. If this is a foster-adopt case, this will be a different date

from the foster care admission date.

Adoption Worker Select an adoption worker from the drop-down menu.

Adoptive Name Indicate an adoptive name, if this applies.

Family Matched Select a date with the calendar icon on the right side of the information box. This is the date when the family was selected.

Identified Family Select a home from the magnifying glass icon on the right side of the information box. For a home to be matched to an adoption

case, the home must have the "Adoptive Home" checkbox checked under their provider type.

Competing Parties Check this box if there are two parties competing for this adoption.



Location Information for Adoption Cases

Track where the adoption will be located or currently is located. Click on the hyperlink "Location" button to pick a adoptive home in extendedReach. The home information will automatically populate the rest of the fields.

This setting can be enabled by an Agency Administrator under Organization Preferences.

Image: "Adoption Location"

Location

Click on the hyperlink to access available locations which

this adoption is or will be located.

Contact Name

Document the name of the contact person related to the

adoptive location.

Phone

Document the phone number of the adoptive location.

Address

Document the address of the adoptive location.



Intake and Discharge Rosters and Summaries

Comprehensive Reporting

Access all adoption case data in centralized reports

Case Management

Track active, intake, and discharged cases

Data Organization

View cases by status, outcome, and other key metrics

extendedReach provides multiple ways to view and track adoption cases through various roster and summary reports. These

tools help agencies maintain oversight of all adoption cases at different stages of the process.



Case Rosters for Adoption Cases

View all open and active adoption cases by going to Case Rosters > Adoption Cases.

Image: "Case Rosters"

Navigate to Case Rosters

Access the main menu in extendedReach

Select Adoption Cases

Choose the Adoption Cases option

View Active Cases

Review all open adoption cases



How do I place a client in a respite home or show

a client is off campus and on respite leave?

EP
by Emily Parks



Setting Up Respite Placements in
extendedReach

Configuration in Program Settings

Respite placements will happen on the Placement Screen by choosing Respite

in the dropdown for Placement Type and Reason for Move.

This wording is configured in Program Settings > Click Program and put into

edit mode > Enter wording below in the boxes labeled 'Placement Type' and

'Reason for Move'.

Recommended Terminology

Use clear, consistent terminology in your system configuration to track respite

placements accurately.

The proper setup in your program settings will ensure all respite placements

are recorded correctly and can be easily reported on.



Best Practices for Respite Tracking

Use Clear Terminology

Use wording like 'To Respite' and 'From Respite' to track if they are leaving or

coming back. Respite requires 2 placements. One to the respite location and one

from the respite location back into the agency placement.

Record Both Movements

Always record both the placement to respite and the return from respite to

maintain accurate records.

T3C requires respite tracking. Homes can only have 40 hrs of respite/year that

is paid. Unless home is under investigation and this is an emergency

placement

Plan Ahead

You can schedule future respite placements and returns in the system to ensure

proper tracking.



Question: Minimum Standards indicate that a child  can be in respite for

up to 40 days - but the T3C the Blueprint indicates a paid respite program

for 40 days per foster home. Since these are worded differently - is the

40 days essentially a cap for the # of paid respite days for a foster home

vs. being the same as Minimum Standards? What if a foster home has 3

placements that go on respite for 14 days - does that count as 42 days of

respite for the foster home - and payment to both the foster home and the

respite home up to the 40 days?

Response: The rate methodology is such that if a single child is placed

with the same foster home for a full 365 days, the CPA will have been

reimbursed the full 40 days of dual pass-through payments for that child.

In order to simplify the tracking (as per child rapidly becomes too much

effort) and ensure that each foster home has adequate opportunity, it’s a

cap for the foster home from the day of placement (although there should

be an attempt to identify how many days the child had in the prior

placement to try to ensure balance and a minimum of disruption over

time). One day for the foster home is one day regardless of how many

children are placed there at that time because each child’s rate has the

dual pass-through days built in.

T3C Tracking of Respite



Troubleshooting Respite Placements

Problem: Missing Respite Location

I don't see the right name or location to place the client in for respite.

Solution for Foster Care Agencies

When you click 'Placement With', choose another family listed in the dropdown. Respite homes need to be set up as homes in order to place a client into

that home. Or, you can leave the client in their current home under 'Placement With', and change the 'Placement Type' and 'Reason for Move' to Respite.

Tracking by homes will be easier for billing and tracking, however.

Solution for Residential Treatment

For Residential Treatment or places with facilities and not foster homes, you can leave the client in their current facility under 'Placement With', and change

the 'Placement Type' and 'Reason for Move' to Respite.



Tracking All Respite

Placements

Access the Respite View

How can I track all of my respite placements?

Navigate to Casework Menu

On the left-hand menu hover over Casework

Select Respite Option

Click on Respite to view all current respite placements



Managing Future Respite Dates

Planning Ahead

Can I place clients on respite for a future date? Can I place

clients back in our organization for a future date?

Answer:  Yes. If you need to adjust either placement, this can

be done in the Case File Tab > Sort by Placements and click

the one you need to change.

Benefits of Advance Planning

• Better resource allocation

• Improved communication with families

• More accurate reporting

• Reduced last-minute scheduling issues



Additional Resources for

Respite Management

Related Articles

Explore other helpful resources in the extendedReach

knowledge base

Sibling Groups

Foster Care - Sibling Groups

Adoption Cases

Tracking Adoption Cases

https://er1.extendedreach.org/hc/en-us/articles/15321738157979-Foster-Care-Sibling-Groups


Creating Homes in the

System: A Complete Guide

Managing properties effectively requires a streamlined approach to

adding new homes to your system. This presentation walks you through

the three primary methods for creating home entries, allowing you to

choose the workflow that best suits your current task.

Whether you're starting from your workspace, working with an existing

inquiry, or creating from a relationship record, you'll learn the step-by-

step process to ensure accurate property records. We'll also highlight

best practices to help you maintain data consistency across your

database.
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Method 1: Adding a Home from Workspace

Locate Add Home Button

Find the "Add Home" button

positioned in the action bar of

your workspace. This button

serves as your starting point for

creating new property records

directly from the main interface.

Select Home Type

Hover over the "Add Home"

button to reveal a dropdown

menu. From here, select either

"Household" or "Other

Residence" depending on the

property type you wish to create

in the system.

Complete Required Fields

After selecting the home type,

you'll be directed to the General

tab containing essential property

information fields. Fill out all

required information accurately

to ensure proper categorization

and searchability.

Save the Record

Once all necessary information

has been entered, click the Save

button to create the new home

record. The system will now

make this property available for

all subsequent processes and

reporting.



Method 2: Creating from an Inquiry

Access Inquiry Record

Navigate to the existing inquiry

record you wish to convert into a

home. This method streamlines

the process by utilizing

information already captured in

the inquiry.

Hover Over Status

Locate and hover over the

"Status" button in the inquiry's

action bar to reveal available

options for this record.

Select Open Home

From the dropdown menu, select

the "Open Home" option to begin

the conversion process from

inquiry to property record.

Complete & Save

Fill out all required fields on the

General tab and click Save to

finalize the new home record

creation.

Converting inquiries to homes maintains data continuity and eliminates the need for duplicate data entry. This method is particularly efficient when

working with prospective properties that have progressed to active status.



Method 3: Creating from Relationships

1 Navigate to People Tab

Access the People Tab within a case or home record to view associated relationships.

This tab centralizes all individuals connected to the current record.

2 Select Person Record

Click on the blue hyperlinked name of the person for whom you wish to create a home.

This action will open the detailed relationship view for that individual.

3 Locate Create Home Option

Within the relationship view, find the "Create Home" option located under the

relationship information section on the left side of the screen.

4 Complete Home Setup

Click on "Create Home" and complete the required fields in the form that appears.

Save your changes to establish the new home record linked to this relationship.

This method is particularly useful when you've already established a relationship record and now need to associate that person with a specific property or residence in the system.



Relationship Information Screen Details

Left Side Panel

The relationship information screen contains critical data in the left panel, including the "Create Home" link

highlighted in blue. This link serves as your gateway to establishing new property records directly from

relationship contexts.

Additional relationship details displayed here provide context for your home creation process, ensuring

proper association between individuals and properties.

Main Content Area

The main content area displays comprehensive relationship data including contact information, relationship

types, and historical interactions. This information helps inform your home creation process.

Pay special attention to address details already captured in the relationship record, as these can be utilized

during the home creation process to maintain data consistency.

The relationship information screen serves as a central hub for managing connections between individuals and properties. Creating homes directly from this interface ensures proper linkage in your database and

streamlines the overall workflow for property management.



Required Fields for Home Creation

General Information

• Home Name/Title

• Property Type

• Status (Active/Inactive)

• Primary Contact

Location Details

• Street Address

• City

• State/Province

• Postal Code

• Country

Property Specifics

• Square Footage

• Bedrooms

• Bathrooms

• Year Built (if applicable)

Regardless of which method you use to create a home, you'll need to complete these essential fields on the General tab. The

system marks required fields with an asterisk, but completing all relevant fields ensures comprehensive property records that

support effective management and reporting.

Remember that complete and accurate data entry during home creation prevents the need for extensive updates later and

improves overall database integrity.



Home Screen



Parent A and Parent B



Best Practices for Home Creation

Use Consistent Naming

Establish a standard naming convention

for all home records to ensure easy

searching and identification across your

database.

Associate All Relevant
Relationships

Link all appropriate individuals to the

home record to maintain complete

relationship tracking.

Apply Proper Categorization

Assign accurate property types and

classifications to support meaningful

reporting and filtering.

Check for Duplicates

Before creating a new home, search the

database to prevent duplicate property

records.

Following these best practices ensures your property database remains clean, organized, and valuable for operational purposes. Consistent

application of these principles across all team members further enhances data quality and reliability.

Remember that the quality of your home records directly impacts reporting accuracy, staff efficiency, and ultimately, the level of service you

can provide to property owners and residents.



Summary: Choosing the Right Creation Method

Creation Method Best Used When Key Advantage

From Workspace Creating entirely new property records Direct access from main interface

From Inquiry Converting prospect properties to active Preserves inquiry data history

From Relationship Establishing properties for existing contacts Maintains relationship continuity

Each home creation method offers specific advantages depending on your workflow and starting point. Choose the approach that minimizes

duplicate data entry and maximizes efficiency for your particular scenario.

Remember that regardless of the method chosen, the end result should be a complete, accurate home record that serves as a foundation for all

subsequent property management activities. Taking the time to create thorough records initially saves significant effort throughout the property

lifecycle.

For additional assistance with home creation or other system functions, contact your system administrator or refer to the complete user

documentation.



Managing Home Inquiries in

extendedReach

Welcome to our comprehensive guide on managing home inquiries within

the extendedReach platform. This presentation will walk you through the

entire process—from setting up inquiry functionality to efficiently tracking

potential foster homes.

Properly managing inquiries is critical for maintaining a healthy pipeline

of foster homes. Following these steps will help your agency effectively

track interested families, convert qualified inquiries into homes, and

maintain accurate records throughout the process.
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Enabling Inquiry Functionality

Organization Settings

Inquiries must first be enabled in

Organizational Settings by an

Agency Administrator. This is a

prerequisite for all inquiry

management.

Administrator Access

Only users with administrator

privileges can modify these settings.

Contact your system administrator if

you need this feature enabled.

Configuration Options

Several options can be configured

for inquiries, including default

assignments and notification

preferences.

Before you can begin processing home inquiries, your organization must activate this feature. This one-time setup ensures that your

team can track potential foster families from first contact through the entire recruitment process.



Creating a New Inquiry

Access the Add Function

Hover over the "Add Home" button located on

the action bar in your workspace. From the

dropdown menu that appears, select "Inquiry"

to begin the process.

Complete General Information

On the General tab, fill out all highlighted

yellow fields at minimum. This includes basic

contact information and identification details

for the prospective home.

Add Inquiry-Specific Details

Navigate to the Inquiry tab to document

specific information about the family's

interests, how they heard about your agency,

and other relevant qualification details.

Creating a thorough inquiry record ensures that your agency captures all relevant information from the beginning. This foundation will make follow-up more

effective and streamline the process if the inquiry moves forward to become a licensed home.



Inquiry Form Essentials

General Tab Fields

The General tab contains essential identification and contact information:

• Full name of primary contact

• Address and contact details

• Preferred contact method

• Agency branch/location

• Assigned worker

Inquiry Tab Fields

The Inquiry tab captures details specific to the family's interest:

• Interest type (foster, adoption, etc.)

• Referral source

• Child preferences

• Current household members

• Next steps and follow-up plans

Accurate and complete documentation at this stage creates efficiency throughout the recruitment process. Remember that yellow-highlighted fields are mandatory and must be completed before the record can be saved. Additional

fields provide valuable context that helps with recruitment decision-making.



Converting Inquiries to Active Homes

Review Inquiry

Verify all information is complete

and the family meets basic

qualifications

Select "Open Home"

Click the "Status" button on the

action bar and choose "Open

Home" from the dropdown menu

Address Requirements

Complete any highlighted due

reports or activities that appear

after conversion

Begin Home Process

Proceed with standard home study

and certification procedures

Converting a promising inquiry into an active home record allows your agency to begin the formal home study process. This transition automatically creates all

required documentation and activities based on your agency's configuration, ensuring no steps are missed in the licensing process.



Managing Inquiry Closures

Initiate Closure

Click the "Status" button on the action bar and select "Close Inquiry" from the dropdown

menu to begin the closure process.

Document Reason

In the popup window, select the appropriate closure reason from the dropdown menu.

This helps track recruitment effectiveness and identify patterns.

Add Details

Provide specific notes about why this inquiry didn't proceed. This information is valuable

for improving recruitment and screening processes.

Closure Date

Verify the closure date is accurate. This date will be used in reporting metrics about

inquiry duration and conversion rates.

Properly closing inquiries that don't proceed to licensure is just as important as converting successful ones. Accurate closure data helps your agency refine recruitment strategies and identify

opportunities to improve conversion rates over time.



Tracking and Viewing Inquiries

Access Inquiry Roster

Select "Inquiries" from the Homes Rosters section under Homes in the side menu navigation.

This displays all current inquiries in a comprehensive list view.

Review Inquiry Dashboard

The Inquiry View provides a snapshot of all inquiries with their interests, planned next actions,

and date of last contact—all critical for effective follow-up.
Access Individual Records

Click on any blue hyperlinked name to access the complete home inquiry file with all details

and notes.
Filter and Sort

Use built-in filtering and sorting options to prioritize inquiries by date, assigned worker, or

other relevant criteria.

Regularly reviewing your inquiry roster helps ensure that no potential foster home falls through the cracks. The inquiry dashboard is designed to highlight which families need follow-up and which are most likely

to proceed to licensure based on their interests and engagement.



Online Inquiry Form Integration

Setup Configuration

Navigate to Organization Settings → Organization Preferences → Family Web →

Inquiries to access form settings

Set Default Assignments

Designate which staff member will receive new online inquiries and configure email

notifications

Implementation Options

Choose to use either a direct URL link or embed the form into your agency's website

using the provided code

Automatic Processing

When submitted, form data creates new inquiry records without manual entry, saving

staff time

The online inquiry form provides a seamless way for potential foster families to express interest through your website. This automated process eliminates manual data entry and ensures inquiries are immediately captured in the system. For custom field additions or other form

modifications, contact support at support@extendedreach.com.



Mastering the Inquiry Tab in

ExtendedReach

Welcome to your comprehensive guide to using the Inquiry Tab within

ExtendedReach's Home Screen. This powerful feature helps social

workers and case managers efficiently track potential foster and adoptive

families before formally opening their home in the system.

Throughout this presentation, we'll explore each component of the Inquiry

Tab, demonstrating how it streamlines your workflow by organizing

crucial information in one accessible location. You'll learn how to track

application progress, record home details, document marital information,

and manage interview responses.
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Navigating the Inquiry Tab
Interface

Purpose

The Inquiry Tab serves as a centralized location to track all pre-approval

information for potential foster or adoptive homes.

Layout

The interface is organized into four key sections: Next Steps, Home

Information, Marital Information, and Interview Questions.

Accessibility

All team members with appropriate permissions can view and update

information, ensuring consistent communication across your agency.

The Inquiry Tab provides a structured approach to managing potential placements before

they officially enter your system. This organization helps eliminate paperwork and reduces

the risk of missing important details during the early stages of family assessment.



Tracking Application Progress with Next Steps

Customizable Steps

Your agency administrator can modify these

steps in Organization Preferences to match

your specific workflow.

Visual Progress Tracking

Easily see which stage each applicant has

reached in the approval process.

Timeline Management

Monitor how long applicants have been at each

stage to identify potential bottlenecks.

The Next Steps section transforms your application process into a visual pipeline, allowing you to quickly assess where each inquiry stands. This feature

helps ensure no potential families fall through the cracks and provides supervisors with visibility into workload distribution across your team.



Recording Essential Home Information

Placement Preferences

Document what types of placements the family is interested in receiving (foster care, adoption, respite,

etc.).

Age Range Specifications

Record the minimum and maximum ages of children the family is willing to consider for placement.

Contact Information

Store primary phone numbers, email addresses, and other essential contact details for quick reference.

Customizable Fields

Your agency administrator can modify the "Interested In" and "At least # years old" fields to match your

organization's specific needs.

The Home Information section provides a snapshot of what makes each potential placement unique. By

capturing these details early in the process, you can better match children with the right environments and

avoid misalignments that might disrupt placements later.



Documenting Marital Information

Marriage Duration

Record the number of years the couple has been married, which

is often a critical factor in determining eligibility for certain types of

placements.

Many agencies have minimum marriage duration requirements,

making this field essential for preliminary screening.

Previous Marriages

Document whether either spouse has been previously married,

which may require additional documentation or background

checks.

This information helps identify if additional interviews or

documentation may be needed regarding previous family

dynamics.

Understanding a family's marital history provides important context for assessing stability and relationship dynamics. This information

helps you anticipate potential challenges and identify strengths that might benefit children placed in the home. Complete documentation

at this stage simplifies the formal home study process later.



Capturing Interview Responses

Standardized Questions

ExtendedReach provides a set of common interview questions that help assess family readiness and

identify potential concerns early in the process.

Detailed Responses

Record comprehensive answers that capture nuances in how families approach challenging

situations or describe their motivations for fostering or adopting.

Assessment Tools

Use these responses as preliminary indicators of family strengths and areas where additional training

or support might be beneficial.

Historical Record

Maintain a permanent record of initial responses that can be compared with later interviews to identify

consistency or growth over time.

The Interview Questions section transforms casual conversations into structured assessment data. By documenting responses systematically, you build a foundation for the formal home study while identifying potential red

flags or special strengths early in the process.



Implementing Best Practices

Complete All Fields

Even seemingly minor details can provide

important context for placement decisions.

Update Regularly

Maintain current information as families

progress through the application process.

Add Context

Use notes fields to provide qualitative insights

beyond the standard questions.

Share Information

Ensure colleagues can access and

understand key details about potential

placements.

Following these best practices ensures the Inquiry Tab becomes a valuable tool rather than just another data entry requirement. When properly

maintained, this information streamlines the transition from inquiry to open home, reducing duplicate work and preventing important details from being

overlooked.

Remember that the information gathered during this phase often forms the foundation of your relationship with potential foster or adoptive families,

making accuracy and thoroughness especially important.



Getting Support and Next Steps

Review Organization
Preferences

Work with your administrator to

customize the Inquiry Tab fields to match

your agency's specific workflow and

requirements. Tailoring these options can

significantly improve efficiency.

Develop Internal Protocols

Establish guidelines for when and how

the Inquiry Tab should be completed to

ensure consistency across your team.

Consider creating a checklist for new

staff members.

Reach Out for Support

Contact ExtendedReach support at

support@extendedreach.com if you

encounter technical issues or have

questions about optimizing your workflow

within the system.

The Inquiry Tab is designed to make your job easier by organizing critical information in a single, accessible location. By fully utilizing this

feature, you can streamline your workflow, improve communication within your team, and ultimately make better placement decisions for the

children in your care.

Remember that ExtendedReach continuously updates its features based on user feedback. Share your suggestions with the support team to

help shape future improvements to the system.



Understanding the Home

Screen: General Tab

Welcome to this comprehensive guide to the General Tab in

extendedReach's Home Screen. This presentation will walk you through

each section of this critical interface, explaining how to properly enter and

manage home information in the system.

As social workers and agency staff, efficiently managing home data is

essential for providing quality care and maintaining accurate records.

Let's explore how to maximize the functionality of the General Tab to

streamline your workflow and ensure compliance with documentation

requirements.
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Home Screen Overview

Home Information

Contains basic identifiers, worker assignments, and key dates

Household Information

Records parent details including contact information and demographics

Address & Contact

Manages physical and mailing addresses plus communication details

Additional Sections

Includes home details, school information, and emergency planning

The General Tab serves as your primary interface for managing home records. Each section

is designed to capture specific information needed for case management, licensing

requirements, and agency reporting.



Home Information Section

Identification & Assignment

• Agency Home # - Unique identifier for

the home

• Worker - Primary caseworker

assignment

• Adoption Worker - Separate worker for

adoption cases

Timeline & Classification

• Inquiry/Intake Dates - Track initial

contact timeline

• Provider Type - Reflects current status

in licensing

• Home Type - Based on agency-specific

categories

Status Indicators

• On Hold - Flag homes temporarily unavailable

• Special Investigation - Track homes under review

• Track Inquiry - Maintain history across status changes

This section establishes the administrative framework for each home record. Pay particular attention

to Provider Type, as this classification determines available features and workflows throughout the

system. The status indicators help maintain visibility on homes requiring special attention.



Household Information Details

Personal Identifiers

The system provides fields for complete demographic information for each parent, including full name, date

of birth, gender, race, religion, and birthplace. These fields help with matching families to children with

specific needs.

Legal identifiers like SSN and driver's license numbers are also captured here, which streamlines

background check processes and verification requirements.

Employment & Income

Work details including employer name, occupation, work hours, employment date, and monthly income help

assess the family's stability and availability. This information is crucial for placement decisions and support

planning.

Educational background is also recorded, providing insight into the household's academic resources and

potential specializations that might benefit particular placements.

Names entered in the Parent A and Parent B fields will automatically populate throughout the system, so accuracy is essential. Remember that complete household information is required for licensing compliance and

helps with appropriate matching of children to homes.



Address and Contact Management

Physical Address

Enter the home's physical location, including street address, city, state, and county. This

information is used for home visits, geographic reporting, and jurisdiction determination.

Mailing Address

When different from the physical address, check "Separate mailing address" to reveal

additional fields. This ensures communications reach the family correctly.

Contact Methods

Multiple contact methods (main phone, work phone, fax, primary and secondary email)

ensure you can reach families through their preferred channels.

Maintaining accurate address and contact information is critical for agency communications,

emergency notifications, and compliance mailings. The system allows tracking of both physical

and mailing addresses to accommodate families with P.O. boxes or other special mailing needs.



Home Physical Information

Bedrooms

Track bedroom count and details for capacity

assessment and compliance

Vehicles

Document transportation resources for home

visits and activities

Pets

Record pet information for placement

compatibility and safety considerations

Accessibility

Note handicap access and other

accommodation features

The Home Information section captures physical characteristics that impact placement decisions. The number selected for bedrooms, vehicles, and pets

will dynamically generate additional detail fields below. For agencies using Advanced Pet and Vehicle Management, more comprehensive tracking

options are available.

These details are especially important for licensing requirements and help determine the home's capacity and suitability for specific placements,

particularly for children with special needs or accessibility requirements.



School and Education Information

School District

Record the nearest school

district serving the home's

location, essential for

educational planning and

coordination.

School Levels

Document the names of

closest elementary, middle,

and high schools for

educational continuity

planning.

Transportation
Planning

Understanding school

proximity helps assess

transportation needs and

logistics for school

attendance.

Educational stability is a critical factor in successful placements. This section helps

caseworkers plan for educational continuity when placing children, supporting efforts to

maintain school stability whenever possible. Complete school information also facilitates

coordination with educational liaisons and school district personnel.

While the system captures basic school proximity information, remember to document

specific educational needs and accommodations in the child's education plan for

comprehensive educational support.



Emergency Planning and Communication Preferences

Disaster Planning

Record emergency location information for crisis situations

Mailing Preferences

Set options for agency communications and address validation

Technical Support

Contact support@extendedreach.com for additional assistance

The Disaster Plan section becomes available when enabled in Organization Preferences. This critical information ensures you can locate families during

emergencies or natural disasters. Complete and up-to-date emergency location data supports agency disaster response protocols and continuity of care.

The Mailing List Preferences section allows you to document communication restrictions and address issues. Use "Do not include in mailing list" for families

who opt out of agency mailings, and "Returned mail – bad address" to flag homes with delivery problems that require address verification.



Foster Home Licensing: From

Inquiry to Placement

Welcome to our guide on the foster home licensing process. This

presentation will walk you through the complete lifecycle of establishing a

foster home—from the initial inquiry stage through application and finally to

full licensing status.

Understanding this process is essential for all social workers and agency

staff involved in expanding the network of qualified foster homes. We'll

provide step-by-step instructions for navigating the ExtendedReach system

to manage each phase efficiently.

If you have specific questions not covered in this presentation, please

contact support at support@extendedreach.com.

EP
by Emily Parks



Understanding the Licensing Journey

Inquiry Phase

Initial contact with prospective foster parents exploring the possibility of becoming

licensed

Application Phase

Formal petition process where interested families submit required documentation

Licensing Phase

Final authorization allowing homes to accept foster child placements

The foster home development process follows these three distinct phases. Each stage builds upon

the previous one, with specific requirements and documentation needed before advancing.

Understanding the complete journey helps social workers guide prospective families through what

can sometimes be a complex process.

Throughout this presentation, we'll examine each phase in detail, providing practical guidance for

managing homes at every stage using the ExtendedReach system.



Managing the Inquiry Process

Access the Add Home Function

Hover over "Add Home" in your action bar on your

workspace, then select "Inquiry" from the

dropdown menu

Complete Initial Information

Enter prospective foster parents' contact details

and preliminary information about their interest

and home situation

Document Interview Responses

Record answers to standardized inquiry questions

and schedule follow-up actions as needed

Inquiries represent the initial stage where prospective families are exploring the possibility of becoming foster parents. This exploratory phase allows both the agency and

the family to determine if pursuing licensing is appropriate.

To view all current inquiries in your system, hover over "Home Rosters" in the navigation menu and select "Inquiries." This will display all homes currently in the inquiry

phase, allowing for efficient follow-up and management of the prospective foster parent pipeline.



Working with Home Inquiries

Accessing Inquiries

Hover over Home Rosters in the main navigation and select "Inquiries" to view all prospective homes in this phase

Tracking Interview Questions

Record responses to standardized inquiry questions to evaluate suitability for fostering

Managing Next Steps

Document and track workflow tasks to ensure all inquiry requirements are completed

The inquiry management process provides structure for the initial evaluation of potential foster parents. During this phase, staff should focus on gathering preliminary information,

answering questions about the fostering process, and helping families understand the commitment involved.

Thorough documentation during the inquiry phase creates a foundation for the application process if the family decides to move forward. It also helps identify potential concerns

early in the process, saving time and resources for both the agency and the prospective family.



Moving from Inquiry to Application

Change Status to "Open Home"

Select the "Status" button in the action bar and choose "Open Home" from the

dropdown menu

Select "Applicant" Provider Type

In the General Tab, change the Provider Type designation to "Applicant"

Complete Required Fields

Fill out all necessary information in the General Tab to establish the application

record

When a prospective family decides to formally pursue foster parent licensing, you'll transition them from the Inquiry phase to the Application phase. This represents a significant step in their

journey and requires more detailed documentation and assessment.

During the application phase, families begin completing formal documentation, background checks, home studies, and training requirements. The ExtendedReach system helps track all these

components, ensuring that nothing is overlooked in the licensing process.



Managing Applications in Progress

Application Documentation

Track submission of required forms,

background checks, references, and

financial verification through the

system

Home Study Process

Schedule and document home visits,

interviews with family members, and

safety assessments of the physical

home environment

Training Requirements

Monitor completion of mandatory

training hours and specialized

education modules required for

certification

To access all homes currently in the application phase, navigate to "Home Rosters" and select "Applicants/Unlicensed Homes." This

view allows you to monitor the progress of all applications in process at your agency.

The application phase typically takes several months to complete as families work through various requirements. During this time,

social workers should maintain regular contact with applicants, providing support and guidance to help them successfully complete all

licensing components.

Clear documentation in the system helps track each family's progress and identifies any potential barriers to licensing that may need

to be addressed.



Completing the Licensing Process

When all application requirements have been met and approved, you'll finalize the licensing process in the system. This crucial step officially designates the home as available for foster placements according to the parameters established in their license.

The licensing information includes critical details that will be used for placement matching, such as the home's maximum capacity, preferred age ranges, gender specifications, and any specialized certifications. Accurate documentation of these parameters ensures

appropriate placements that match both the children's needs and the foster home's capabilities.

Change Provider Type

Update from "Applicant" to appropriate licensed provider category

in the General Tab

Add License Details

Navigate to Licensing Tab and click "Add License" to create the

official license record

Set Placement Parameters

Establish capacity limits, age ranges, gender preferences, and

specialized capabilities

Document Effective Dates

Enter license issue date, expiration date, and renewal timeline

information



Maintaining Licensed Foster Homes

365

Days Until Renewal

Standard license duration before renewal

required

90

Days Before

Recommended timeline to begin renewal

process

30

Days Between

Suggested frequency for home check-ins

Once homes achieve licensed status, they can be accessed through the "Licensed Homes" option under Home Rosters. This view

displays all currently active foster homes available for placements.

Licensed homes require ongoing monitoring and support to maintain compliance with regulations. Regular check-ins, documentation

of any changes to the home environment, and tracking of additional training are all important aspects of licensed home management.

The licensing renewal process should begin well before the expiration date to ensure continuity. ExtendedReach can help by

generating reports of upcoming renewals, allowing staff to proactively work with foster families to complete necessary requirements

and maintain their licensed status without interruption.



Advanced Pet and Vehicle

Management Guide

Welcome to the comprehensive guide on managing pets and vehicles within

our system. This presentation will walk you through how to activate,

configure, and utilize the advanced management features for tracking both

pets and vehicles associated with your homes.

Our platform allows you to add unlimited pets and vehicles, helping you

maintain complete records with customized reporting options. Throughout

this guide, you'll learn the step-by-step processes needed to successfully

implement these features across your organization.

If you have questions beyond what's covered here, please reach out to our

support team at support@extendedreach.com.
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Understanding the Benefits

Unlimited Tracking

Add as many pets and

vehicles as needed with

no system limitations

Clear Identification

Pet and vehicle names

appear alongside

reports for easy

reference

Historical Records

Maintain active and

inactive records for

complete historical

documentation

Compliance

Management

Track required

documentation with

expiration dates and

alerts

The advanced management system integrates seamlessly with your existing workflows, allowing for comprehensive tracking similar to how

you manage household member documents or trainings. This approach ensures all critical information is organized and accessible when

needed.



Enabling Advanced Management Features

Access Organization
Settings

Navigate to the Organization

Settings section of your admin

panel to begin the setup process

Open Organization
Preferences

Within Organization Settings,

select the Organization

Preferences option to view

available system configurations

Configure Settings

Locate and enable "Homes:

Advanced vehicle management"

and "Homes: Advanced pet

management" checkboxes

Verify Activation

Navigate to any home record and

confirm that the Vehicles and Pets

sections now appear on the

General tab

Once activated, these features become immediately available across your entire organization. The settings apply globally, allowing all authorized users to access

and utilize the pet and vehicle management capabilities within their assigned homes.



Adding and Managing Vehicles

Add Vehicle

Click "Add Vehicle" on the home's General tab

Enter Details

Complete Name, Description, and Tag fields

Save Record

Click OK to create the vehicle record

Manage Reports

Add vehicle-specific documentation

When adding vehicles, be specific with descriptions to easily identify each one. The Tag field can

be used for license plate numbers, vehicle identification numbers (VIN), or other unique

identifiers. This information will help distinguish between multiple vehicles within the same home.

Vehicle records remain accessible on the home's General tab, where they can be edited or

marked as inactive as needed. This flexibility ensures your records stay current even as a family's

vehicle inventory changes over time.



Configuring Vehicle Reports

Access Home Report Types

Navigate to Organization Settings > Home Report Types to configure vehicle

documentation requirements

Create Vehicle Report Type

Set Report Category to "Vehicle" and configure expiration dates and other

parameters based on agency requirements

Add Reports to Vehicles

Return to a home record and add the configured report types to specific vehicles

Monitor Compliance

View vehicle-specific reports on the Compliance Tab and Foster Family Website

Common vehicle report types include insurance verification, registration documents, safety

inspections, and maintenance records. Each report will display with the vehicle name for clear

identification. This association helps staff quickly identify which documents belong to which

vehicle, especially in homes with multiple vehicles.



Adding and Managing Pets

Creating Pet Records

• Navigate to a home's General tab

• Scroll to the Pets section

• Click "Add Pet" button

• Enter Name and Description

• Click OK to save the pet record

Pet Information Tips

• Include species in the description

• Note breed information when relevant

• Consider adding age or size details

• Include special needs or behaviors

Managing Inactive Pets

• Click on pet's hyperlinked name

• Check "Inactive" box

• Click "Show Inactive" to view all inactive pets

• Maintain historical records even for departed pets

The pet management system allows for detailed tracking of all animals in a foster home. This capability is particularly important for agencies that need to document pet vaccination records, temperament assessments, or

other pet-related compliance requirements that might impact child placement decisions.



Configuring Pet Reports

Vaccination Records Temperament Assessments Veterinary Exams Training Certificates Pet Insurance

To set up pet reports, navigate to Organization Settings > Home Report Types. Select "Pet" as the Report Category and configure expiration dates and other parameters based on your agency's requirements. These reports will help ensure all pets in the home meet safety

and health standards.

Once configured, pet reports will appear on the Compliance Tab with the pet's name clearly displayed next to the report name. This makes it easy to track which documentation belongs to which animal. The same information is viewable on the Foster Family Website, allowing

families to monitor and maintain their own pet compliance requirements.



Best Practices and Next Steps

Full Implementation

Integrate pet and vehicle tracking into your standard processes

Regular Maintenance

Update records when pets or vehicles change

Staff Training

Ensure all team members understand the system

Initial Setup

Configure report types and enable features

For the most effective implementation, begin by documenting all current vehicles and pets across your homes. Create a standardized approach to naming and

describing these assets to ensure consistency throughout your organization. Consider developing a regular review process to verify all information remains current.

Remember that complete pet and vehicle documentation contributes significantly to comprehensive safety assessments. By maintaining accurate records, you're

helping ensure the safety of children placed in these homes while also protecting your organization through proper compliance management.



Navigating the Home Screen

Licensing Tab: Complete

User Guide

Welcome to your comprehensive guide to the Licensing Tab in the Home

Screen. This essential feature allows social workers and case managers to

efficiently record, track, and manage home licenses, approvals, and

certifications within the Extended Reach system.

Throughout this presentation, we'll walk through each component of the

Licensing Tab, providing step-by-step instructions and practical tips to

streamline your workflow. Whether you're new to the system or looking to

enhance your existing knowledge, this guide will help you maximize the

functionality of this important tool.
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Understanding the Licensing Tab

Layout

Central Location

The Licensing Tab serves as your central hub for all licensing information

related to a specific home or family.

Add License Button

Prominently displayed to allow quick creation of new license records with just

one click.

License Overview

View all existing licenses in a clean, organized table format with key

information displayed.

Quick Access

Blue hyperlinked text under the "Type" column provides immediate access to

detailed license information.



Adding New Licensing Information

Click "Add License"

Begin the process by clicking the clearly visible "Add License" button at the top of the licensing

section.

Complete Form Fields

Enter all required license information in the provided fields, ensuring accuracy and completeness.

Save Information

Submit the form to create a new license record that will appear in the license overview table.

Access & Update

Click on any license in the Type column to view or modify existing license details as needed.

When reviewing the license overview table, you'll notice that each license entry displays essential information at a

glance, including type, approval date, and expiration date. This organized layout helps you quickly identify

licenses that may be nearing expiration or require updates.



Configuring License Details & Preferences

Capacity Settings

Define the maximum number of children the home is authorized to

accommodate, ensuring compliance with local regulations and

home study recommendations.

This critical information helps prevent overplacement and

maintains appropriate supervision ratios for the safety and

wellbeing of placed children.

Demographic Preferences

Document the home's preferences regarding age range, gender,

and race of potential placements to facilitate appropriate

matching.

While preferences are recorded, remember that these should be

considered alongside agency policies regarding non-

discrimination and the specific needs of children awaiting

placement.

Service Type Selection

Indicate which service types the home is licensed for by checking

the appropriate boxes from the available options.

This classification ensures that homes are only considered for

placements that match their training, experience, and licensing

qualifications.



Documenting Placement Comments

Special Considerations

Document any special skills, training, or experiences that make the home

suitable for certain types of placements, such as medical needs, behavioral

challenges, or sibling groups.

Restrictions or Limitations

Note any limitations that might affect placement decisions, such as

transportation constraints, work schedules, or existing family dynamics that

need consideration.

Preference Clarifications

Use this space to provide context or additional details that expand on the

demographic preferences indicated in the structured fields above.

Placement History Insights

Include relevant information about past placement successes or challenges

that might inform future placement decisions for this home.

The Placement Comments field provides valuable qualitative information that complements the structured data in other fields. These insights help placement teams

make more informed decisions that benefit both the children and the foster families, increasing the likelihood of stable, successful placements.



Recording Licensing Process Details

Prior Licensing History

Document whether the home has previously been licensed with your agency or

another organization, which may affect the current licensing process.

Home Study Assignment

Record the date when the home study was assigned to a worker, establishing a

timeline for the licensing process.
Home Study Receipt

Track when the completed home study was received, allowing you to monitor

the progress of the licensing workflow.
Agency-Specific Fields

Complete any additional fields required by your agency's specific processes or

regulatory requirements.

Maintaining accurate records of the licensing process timeline not only helps with internal tracking but also provides documentation that may be required for compliance with state

regulations and accreditation standards. Regular reviews of this information can help identify bottlenecks in your licensing process.



Adding Comprehensive Licensing Comments

Document Significant Events

Record notable occurrences during the licensing

process, such as unique circumstances,

exceptions granted, or special conditions imposed

on the license.

Track Communication History

Note important conversations with the family

regarding their license, including discussions

about renewal requirements, additional training

needs, or clarification of licensing standards.

Highlight Areas for Follow-up

Identify any items that require future attention,

such as pending documentation, scheduled

inspections, or upcoming compliance checks that

will need to be addressed.

The Licensing Comments section serves as a chronological record of the home's licensing journey, providing valuable context for anyone working with the family. This

information helps maintain continuity when cases transfer between workers and ensures that institutional knowledge about the home is preserved over time.

Consider using a consistent format for your comments, including dates and the name of the person making the entry, to create a clear audit trail of licensing-related

activities and decisions.



Key Takeaways & Best Practices

Regular Updates

Set calendar reminders to

review and update licensing

information quarterly, ensuring

all data remains current and

accurate.

Complete
Documentation

Maintain comprehensive

records in all sections to

support placement decisions

and demonstrate compliance

with regulatory requirements.

Detailed Comments

Include specific, relevant

details in comment fields to

provide context that structured

data fields cannot capture.

Team Communication

Use the licensing tab as a

communication tool to share

important information about

homes with your placement

team.

Effectively managing the Licensing Tab is crucial for maintaining accurate records and facilitating appropriate placements. If you

encounter any questions not addressed in this guide, remember that support is available at support@extendedreach.com  to assist

you.

By implementing these best practices, you'll help ensure that your agency maintains high-quality data that supports better outcomes

for the children and families you serve.



ExtendedReach Home

Screen: Understanding the

Compliance Tab

Welcome to this comprehensive guide on utilizing the Compliance Tab within

ExtendedReach's Home Screen. This powerful feature provides case

managers and administrators with a high-level overview of document

compliance status across your organization.

The Compliance Tab is designed to help you quickly identify which activities

or reports have been collected, which are missing, or which are approaching

their due dates. Throughout this presentation, we'll explore the tab's

functionality, navigation features, and best practices for maximizing its utility

in your daily workflow.
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Color Coding System: Visual Status

Indicators

Green

Item has been completed OR item is due/expires more than 10 days from now

Red

Item is missing, past due, or has expired

Yellow

Item is currently drafted/in progress or expires within the next 10 days

White

Optional items that appear only when "Show Hidden, Optional Items" is clicked

This intuitive color-coding system enables users to quickly prioritize their compliance tasks

without needing to review each document individually. Remember that the Compliance Tab

displays only the most recent version of each document; for historical versions, refer to the

Home File Tab.



Organizational Structure: Category-Based Arrangement

Standard Categories

Items on the Compliance Tab are grouped into logical categories and

listed alphabetically within each category. Typical examples include:

• Applicant Items

• Home Study

• Criminal Check

• References

• Training

Agency administrators can customize these categories through the

Organization Preferences section under the Keywords tab, allowing you

to align the Compliance Tab with your agency's specific terminology and

workflow requirements.

This organized approach to compliance tracking helps users quickly locate specific document types and assess their status across multiple homes or

applications, streamlining the monitoring process for case managers handling multiple cases simultaneously.



Accessing Documents: Navigation Options

Click Blue Hyperlinks

Access the most recent version of any activity

or report by clicking on the blue hyperlink

displayed next to the item name in the

Compliance Tab.

Use Three-Dot Menu

View previous versions of documents by

clicking the three dots to the right of each

entry, which opens a contextual menu with

additional options.

Add New Versions

For items without expiration dates or with

repeating due dates, click the three dots and

select "Add Report" to create a new version

while preserving the original.

For documents with expiration or due dates, the system automatically links directly to a new version template when clicked, streamlining the renewal process.

This intuitive navigation system ensures that users can quickly access, review, and update compliance documents as needed.



Managing Optional Items and Hidden Documents

Optional Items Display

By default, optional compliance items are

hidden to reduce visual clutter. Click the

"Show Hidden, Optional Items" button at the

top of the Compliance Tab to reveal these

items.

Status Tracking Activation

Once you add a document to an optional

item, ExtendedReach begins tracking its

compliance status using the standard color-

coding system.

Customization Benefits

This approach allows agencies to maintain

comprehensive compliance tracking while

keeping the interface focused on required

documents for day-to-day operations.

The ability to toggle the visibility of optional items provides flexibility for different user roles. Case managers focused on immediate compliance needs

can work with a streamlined view, while quality assurance staff can access the complete compliance picture when conducting thorough reviews.



Handling Expiration Dates and Document
Renewals

Automatic Expiration Tracking

The system automatically tracks expiration dates for time-sensitive documents like background

checks, training certifications, and licenses.

Advance Warning System

Documents approaching expiration within 10 days appear with a yellow status indicator,

providing advance notice to prepare renewals.

Simplified Renewal Process

Clicking on an expired or expiring document link automatically directs you to the form for

creating a new version, streamlining the renewal workflow.

Historical Version Access

Previous versions remain accessible through the three-dot menu, maintaining a complete

compliance history for audit purposes.

This automated expiration tracking system helps ensure your agency maintains continuous compliance by

proactively identifying documents that require renewal, reducing the risk of overlooking critical compliance

deadlines.



Accessing Previous Document Versions

Locate Document

Find the document in the appropriate category section of the

Compliance Tab

Open Menu

Click the three dots to the right of the document entry

Select Version

Choose from the list of previous versions in the dropdown menu

View Document

Access the historical document in read-only or editable mode

depending on permissions

While the Compliance Tab focuses on current document status, this version history access ensures you can review documentation changes over time. This feature is particularly valuable during audits or when evaluating a

home's compliance history for recertification decisions.



Agency-Wide Compliance Tracking and Reporting

Access Tracking

From your Workspace, hover over "Home" in

the left menu, then select "Home Tasks" →

"Compliance Tracking"

Apply Filters

Filter by Provider Type using the Household

Types dropdown at the top of the screen

Export Data

Click "Excel" to export the filtered compliance

data to a spreadsheet for further analysis

Analyze Results

Review compliance trends and identify areas

needing attention across your agency

This agency-wide view provides supervisors and administrators with a powerful tool for monitoring overall compliance health. The export functionality enables creation of custom reports for board meetings,

accreditation reviews, or internal quality assurance processes. Regular review of these comprehensive reports can help identify systemic compliance issues before they become problematic.



Managing Relationships with

the People Tab in

extendedReach

Welcome to this comprehensive guide on using the People Tab within

extendedReach's Home Screen. This powerful feature allows you to efficiently

store and manage information about household members, non-household

members, and additional resources used by homes in your agency.

Throughout this presentation, we'll explore the layout, functionality, and best

practices for utilizing the People Tab. You'll learn how to add relationships,

manage expiration dates and clearances, and leverage the Address Book

integration to streamline your workflow.

Let's dive in and discover how to maximize this essential tool for your agency's

relationship management needs.

EP
by Emily Parks



Understanding the People Tab Layout

Centralized Information Storage

The People Tab serves as a centralized

repository for storing basic information about

household members, emergency contacts,

non-household members, and other

individuals connected to a home.

Agency-Wide Accessibility

All data stored within the People Tab is

accessible to all authorized users within your

agency, ensuring consistent information

sharing and collaboration.

Multiple Addition Methods

The system offers two distinct methods for

adding people: directly through the "Add

Relationship" button or by copying

individuals from the existing Address Book

database.

The People Tab's intuitive layout makes it easy to quickly view, add, and manage all relationships associated with a home. This visual organization helps ensure

that important connections are properly documented and maintained within your system.



Adding New Relationships

Click "Add Relationship"

Begin by locating and clicking the "Add Relationship"

button at the top of the People Tab interface. This

initiates the process of creating a new relationship

entry within the system.

Select Relationship Type

Use the "Type" drop-down menu to specify whether

the relationship is for a household member, non-

household member, organization, respite home, or a

borrowed bed. This selection determines available

options in the next step.

Define Specific Relationship

Based on your Type selection, choose the

appropriate specific relationship from the

"Relationship" field options. These relationship

designations can be customized by agency

administrators under Organization Preferences.

Adding relationships manually gives you complete control over how each person is categorized within your system. This process ensures that all connections to a home are

properly documented with the correct relationship type, facilitating accurate reporting and compliance tracking.



Relationship Entry Details

Personal Information

Enter basic identifying details including name, date of birth,

gender, ethnicity, and contact information to create a

comprehensive profile for each individual in the system.

Relationship Classification

Properly categorize each person with the appropriate relationship

type and specific relationship designation to ensure accurate

reporting and compliance tracking throughout your agency.

Custom Fields

Depending on your agency's configuration, additional custom

fields may be available to capture specialized information relevant

to your specific programs and reporting requirements.

When adding a new relationship, be thorough in completing all available fields. The more comprehensive the information, the more valuable this record becomes for case management, reporting, and ensuring appropriate

services for each individual connected to the home.

Remember that relationship types can be customized to match your agency's terminology and needs through the Organization Preferences settings, accessible to administrators.



Leveraging the Address Book Integration

Click "Copy from Address Book"

Locate and select this button in the People Tab interface to access

your agency's shared contact database.

Select Contacts

From the pop-up window, check the boxes next to names of

individuals or organizations you wish to add.

Confirm Selection

Click "Ok" to add the selected contacts to the People Tab, creating

relationship entries automatically.

The Address Book integration is particularly valuable for adding professionals and service providers who interact with multiple homes across your agency. County workers, healthcare providers, educators, and other

community resources can be added once to the Address Book and then quickly associated with any home as needed.

This approach ensures consistency in contact information and reduces duplicate data entry, improving overall system efficiency and data integrity.



Managing Expiration Dates and Clearances

Organization Preferences

Agency administrators can enable expiration

date tracking within the People Tab through

system configuration settings.

Date Entry

Add relevant expiration dates for each

relationship when this feature is enabled for

your agency.

Compliance Activities

Create specific activities or reports in the

Compliance tab to track expiration dates for

individuals listed in the People tab.

Notifications

Receive alerts when important clearances or

certifications are approaching expiration

dates.

Tracking expiration dates for clearances, certifications, and other time-sensitive documentation is a critical compliance function. When enabled, the

People Tab can help maintain awareness of upcoming deadlines, ensuring your agency remains in compliance with regulatory requirements.

For comprehensive tracking beyond what's available in the People Tab, we recommend creating specific activities or reports in the Compliance tab to

monitor these important dates for individuals connected to each home.



Best Practices for People Tab Management

Standardize Entry Procedures

Develop consistent protocols for adding and updating relationship information

Regular Review Cycles

Establish schedules for verifying and updating People Tab information

Role-Based Responsibilities

Assign specific team members to maintain different relationship categories

Comprehensive Documentation

Enter complete information for each relationship to maximize system value

Effective management of the People Tab requires intentional processes and clear responsibilities. By establishing standardized entry procedures and regular review cycles, you

can ensure that relationship data remains accurate and up-to-date throughout your agency.

Consider creating internal guidelines that specify which team members are responsible for maintaining different types of relationships. This division of responsibility helps

prevent data gaps and ensures comprehensive coverage of all important connections to each home.



Getting Additional Support

Email Support

Contact the extendedReach support team directly at support@extendedreach.com for personalized assistance with any People Tab

questions.

Knowledge Base

Access comprehensive documentation and step-by-step guides in the extendedReach Help Center for self-service support.

Admin Consultation

Reach out to your agency administrators for organization-specific guidance on People Tab configurations and customizations.

The People Tab is designed to be intuitive, but questions may arise as you explore its capabilities or encounter unique situations. Don't hesitate to

reach out for support through any of these channels when needed.

Remember that your agency administrators can customize many aspects of the People Tab's functionality through Organization Preferences, so

they're an excellent resource for questions about configuration options and agency-specific processes.



Navigating the Home Screen:
Home File Tab Guide

Welcome to your comprehensive guide for navigating the Home File Tab in

ExtendedReach. This powerful feature allows you to efficiently manage all

your home-related documentation in one centralized location. Whether

you're tracking activities, monitoring reports, or reviewing placement

information, this guide will help you maximize your productivity.

We'll walk through the tab's layout, filtering options, and download

capabilities to ensure you have complete mastery of this essential tool. If

you encounter questions beyond the scope of this guide, remember that

support is always available at support@extendedreach.com.
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Understanding the Home File Tab Layout

Comprehensive Overview

The Home File tab provides a complete view of all

documentation related to a specific home, including

completed, due, and expiring items.

Powerful Filtering

Easily filter content to focus on specific activities, reports,

placements, or revisions that matter most to your current task.

Historical Tracking

Access a complete history of all documentation, allowing you

to track changes, monitor progress, and ensure compliance

with requirements.

Convenient Downloads

Download all home documentation directly to your computer

in an organized zip folder for offline access or reporting

purposes.



Filtering Home Records with "Show" Options

Field Name Description

Activities List of all activities that are coming due or have been completed by the home

Case Notes All of the case notes that have been compiled for the home

Daily Activities View all daily activities completed or coming due

Placements Placements that have been made

Reports List of reports that are coming due or have been completed by the home

Revisions List of any revisions that have been made

The "Show" dropdown menu allows you to customize your view by selecting specific record types to display. By default, all records pertaining to the home are shown, but you can narrow your focus to just what you need for your current task. This

filtering capability saves time when working with homes that have extensive documentation.



Additional Record Types in the Show Menu

Training Records

Access a complete list of all training

that has been completed by household

members as well as upcoming required

training. This helps ensure compliance

with certification requirements and

identifies any knowledge gaps that

need to be addressed.

Training records include completion

dates, certification expiration

information, and links to associated

documentation.

Audit Log

Review all recent activity in the home

profile, including who has accessed it,

edited it, or created any items. This

comprehensive tracking provides

accountability and helps maintain the

integrity of your documentation.

The audit log is particularly useful for

quality assurance reviews and

compliance verification, showing a

complete history of all interactions.

Recently Deleted

Access items that have been deleted

from the home profile within the past

90 days. This safety feature allows you

to recover accidentally deleted

information and maintain complete

records even after removal.

Recently deleted items can be restored

to their original location with full

metadata intact.



Downloading Files from the Home File Tab

Locate Download Option

Find the "Download Files" option in the upper right corner of the Home File tab interface.

Initiate Download

Click the option to start the download process, which will collect all available documentation.

Save Zip Folder

Choose where to save the compressed zip folder containing all home documentation.

Access Documents

Extract the zip folder to access all files organized in chronological order for easy reference.

The download feature provides a convenient way to create local backups of all home documentation or prepare

files for court submissions, audits, and other reporting requirements. All downloaded files maintain their original

format and naming conventions for consistency.



Downloaded Files Organization

Chronological Order

All downloaded files are automatically organized in

chronological order, making it easy to follow the history and

progression of documentation over time.

This organization helps when preparing timeline reports or

reviewing historical compliance.

Preserved Metadata

Each file retains its original metadata, including creation date,

author information, and any special classifications or tags

assigned in the system.

This ensures that downloaded documents maintain their

context and relevance.

Original Formatting

Documents are downloaded in their native format, ensuring that

all formatting, signatures, and embedded content remain intact

and accessible.

This preserves the integrity of official documentation for legal or

compliance purposes.

When you extract the downloaded zip folder, you'll find a well-organized file structure that mirrors the organization within ExtendedReach. This makes it simple to locate specific documents even when working

offline or sharing information with stakeholders who don't have direct system access.



Best Practices for Home File Management

Regular Reviews

Schedule weekly reviews of due and

expiring items to ensure timely

completion of required documentation

Consistent Naming

Use standardized naming conventions

for all uploaded documents to improve

searchability

Targeted Filtering

Utilize the Show menu to focus on

specific document types when

completing related tasks

Periodic Backups

Download complete home files

quarterly for backup and offline

reference purposes

Implementing these best practices will help streamline your workflow and ensure that all home documentation remains organized

and accessible. The Home File tab becomes significantly more powerful when used consistently with these strategies, reducing

the time spent searching for information and minimizing the risk of missed deadlines.



Key Takeaways & Next Steps

Master the Interface

Become proficient with all Home File Tab features

Utilize Filtering

Learn to efficiently filter records for focused work

Download Strategically

Implement regular download practices for backups

Customize Your Workflow

Adapt these tools to your specific needs

Now that you understand the capabilities of the Home File Tab, we recommend exploring each feature hands-on to reinforce your learning. Start by reviewing

your current homes and practicing the filtering options to find specific documentation. Try downloading files for one of your homes to familiarize yourself with

the organization of the downloaded content.

For additional assistance or to suggest improvements to the Home File Tab functionality, contact ExtendedReach support at support@extendedreach.com.

Our team is committed to helping you maximize your efficiency with our software.
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Understanding and Utilizing
the Family Web Tab

The Family Web Tab is a powerful feature in ExtendedReach that enhances

communication between agencies and foster families. This presentation will

guide social workers and agency staff through the functionality, layout, and

practical applications of the Family Web Tab to improve family engagement

and streamline information sharing.

We'll explore how to navigate the tab's interface, post messages, monitor

activity, invite families, and view the platform from the family's perspective.

By the end of this presentation, you'll be equipped to leverage this tool

effectively in your daily work with foster families.

EP
by Emily Parks



Enterprise Financials: Managing
Home Reimbursements &
Adjustments

Welcome to our comprehensive guide on using the Financial Tab in the Home Screen

of extendedReach. This powerful feature, available exclusively with the Enterprise

Financials add-on, allows you to efficiently manage reimbursements and adjustments

for foster homes within your organization.

Throughout this presentation, we'll walk through each aspect of the Financial Tab,

from navigation basics to creating and managing financial transactions. By the end,

you'll have a solid understanding of how to leverage these tools to streamline your

financial management processes.

EP
by Emily Parks



Comprehensive Guide to

Tracking Adoptive Homes in

extendedReach

Welcome to this comprehensive training on managing adoptive homes within

the extendedReach platform. This presentation will guide agency staff

through the complete process of tracking adoptive homes—from initial

application to closing. You'll learn efficient navigation techniques, key

features, and best practices that streamline your workflow.

We'll explore the system's capabilities to help you maintain accurate records,

monitor applicant progress, and ensure compliance with adoption

requirements. Let's begin with understanding how to properly establish and

track adoptive homes in the system.

EP
by Emily Parks



Setting Up An Adoptive Home Record

Initial Setup Process

Creating a new adoptive home record requires specific actions to ensure proper

categorization in the system. First, navigate to the home creation screen where you'll

find various home type options.

The key step is checking the "Adoptive Home" checkbox, which activates adoption-

specific fields and tracking capabilities. This designation ensures the home appears

in adoptive home reports and dashboards.

Date Documentation

After designating the home type, you must select the Adoption Application date using

the calendar icon located on the right side of the input field. This timestamp

establishes when the formal application process began.

The application date serves as a reference point for timeline tracking, deadline

management, and compliance reporting. Accurate dating is essential for regulatory

requirements.



Accessing Home Rosters

Navigate to Home Rosters

Begin by locating and clicking on the "Home Rosters" option in the

main navigation menu. This section contains all home management

functions.

Select Adoptive Homes

From the dropdown menu, choose "Adoptive Homes" to filter the

roster specifically for adoption-designated households.

Review Complete Roster

The system displays all currently open adoptive homes in your

agency, allowing for comprehensive oversight and management.

The Home Roster view provides a centralized location to monitor all active adoptive

homes. This interface allows staff to quickly assess status, capacity, and key

metrics across your entire adoptive home portfolio.



Managing Home Adoption

Applications

Access the Intake Menu

Begin by clicking on the "Intake" option in the main navigation menu. This section

handles all incoming applications and referrals.

Select Home Adoption Applications

From the dropdown menu, choose "Home Adoption Applications" to view all

homes that have submitted formal adoption applications.

Review Application Queue

The resulting screen displays all pending applications with status indicators

and next action requirements.

This view provides a comprehensive overview of all homes in various stages of the

application process. Social workers can efficiently track which applications need attention,

identify bottlenecks, and ensure timely processing of all adoption applicants.



Tracking the Home Study Process

Initial Documentation

Track receipt of background checks, financial statements, and references through the

Documents tab.

Home Visits

Schedule and document home inspection visits using the Calendar and Notes features.

Home Study Completion

Upload the completed home study document and update status to "Home Study

Approved."

Final Approval

Record final approval dates and update the home's placement availability status.

The home study process requires meticulous documentation and milestone tracking. ExtendedReach

provides integrated tools to ensure each step is properly recorded, creating a complete audit trail from

initial application through final approval.



Matching Children with Adoptive Homes

Identify Potential Matches

Use the matching tool to find

compatible children based on home

preferences and capacity.

Initiate Introductions

Document initial meetings, visits, and

interactions between child and

prospective family.

Placement Period

Record the placement and track

required supervisory visits during the

pre-adoption period.

Finalization

Document court dates, legal

processes, and adoption finalization

details.

The matching process represents the heart of adoption work. ExtendedReach provides tools to identify potential matches based

on the specific needs of the child and the capabilities of the adoptive home. The system maintains detailed records of each step

in the matching and placement process.



Closing an Adoptive Home

Navigate to Home Status

Locate the home record you wish to close and click on the "Status" dropdown

menu in the home profile.

Select Discharge Option

Choose "Discharge" from the dropdown menu to initiate the closure process for

the adoptive home.

Complete Required Fields

In the pop-up window, enter all mandatory information including discharge

reason, date, and any additional notes about the closure.

4 Submit and Confirm

Click "Submit" to finalize the home closure and update its status in the system

database.

The process for closing adoptive homes mirrors that of foster homes. Note that your organization can customize discharge reasons through Organization Preferences, allowing

for adoption-specific closure categories that better reflect your agency's workflow and reporting needs.



Best Practices & System Optimization

Regular Data Audits

Conduct monthly reviews of adoptive home records to ensure

completeness and accuracy. Look for missing documentation,

outdated information, or incomplete status updates that might

affect reporting or compliance.

Custom Report Creation

Develop specialized reports for adoptive homes to track key

metrics like time-to-placement, successful matches, or homes

nearing license expiration. Use the Reports module to save and

schedule these reports for regular distribution.

Integration with Other Modules

Maximize efficiency by utilizing connections between the Adoptive

Homes module and other system components like Case

Management, Billing, and Document Management for a

comprehensive workflow.

User Training

Ensure all staff receive thorough training on adoptive home

tracking features. Consider designating super-users who can

provide ongoing support and training to new staff members.

Implementing these best practices will enhance your agency's ability to efficiently manage the adoption process. Remember that support is always

available at support@extendedreach.com  for any questions not covered in this presentation. Regular system usage reviews and staff training

sessions will ensure your team maximizes the benefits of extendedReach's adoptive home tracking capabilities.



Understanding the Financial Tab Layout

Overview

The Financial Tab provides a comprehensive view of all financial activities related to a home. You'll

find this tab on the Home Screen when you have the Enterprise Financials add-on activated for your

organization.

This centralized view helps administrators track all financial obligations and corrections in one

convenient location, eliminating the need to navigate between multiple screens or reports.

Filtering Options

Use the "Show" dropdown menu to filter the financial activity display according to your needs. By

default, all financial items are shown, but you can select specific categories:

• Select "Reimbursements" to view only payments due to homes

• Select "Adjustments" to view only corrections to previously recorded amounts



Creating New Reimbursements

Access the Reimbursement Function

From the Financial Tab, click the "Reimbursement" button to create a new

reimbursement record. This initiates the reimbursement creation process.

Complete Required Information

Fill out all necessary fields including reimbursement date, type, case association,

and funding organization. Be thorough to ensure proper financial tracking.

Save the Reimbursement

After verifying all information is correct, click the "Save" button to record the

reimbursement in the system and make it available for processing.

While most commonly used for Days Care reimbursements, this feature can

accommodate various expense types that homes may incur, providing flexibility in your

financial management approach.



Reimbursement Form Fields Explained

Field Name Description

Reimbursement Date The date when the reimbursement was or will

be issued

Type Category of reimbursement (select from

dropdown options)

Case The specific case associated with this expense

Program Relevant program within your organization

Memo Additional notes or context for the

reimbursement

Status Current state of the reimbursement (defaults to

"New")

On Hold/Do Not Post Special handling flags for billing purposes

Understanding each field's purpose ensures accurate record-keeping and proper financial tracking. Take

special note of the "On Hold" and "Do Not Post" checkboxes, as these affect how items appear in the

Billing tab and whether they'll be included in financial processing.



Creating Adjustments

Access the Adjustment Function

From the Financial Tab, click on the "Adjustment"

button to initiate the adjustment creation process.

This opens the adjustment form where you can

correct previously recorded financial information.

Specify Adjustment Details

Determine whether you're adjusting a

reimbursement or days care entry. Select the

adjustment type (increase or decrease) and locate

the specific item being corrected using the "Apply

To" field.

Document and Save

Enter the adjustment amount, provide a detailed

explanation in the memo field to document the

reason for the change, and click "Save" to record the

adjustment in the system.

Adjustments are primarily used to correct Days Care reimbursements when the original amounts were incorrect, but they can also be applied to other expense types. Proper

documentation in the memo field is essential for audit purposes and financial transparency.



Adjustment Form Fields Explained

Primary Information

• Adjustment Date: When the correction

is being made

• Adjust: Choose between

reimbursement or days care

• Type: Specify increase or decrease to

the original amount

Targeting

• Apply To: Select the specific

reimbursement being adjusted

• Amount: Enter the adjustment value

(not the new total)

Documentation

• Memo: Record detailed notes explaining the reason for adjustment

• Status: System-assigned state (defaults to "New")

When creating adjustments, remember that the amount field represents the change value, not the

new total. For example, if you're decreasing a $100 reimbursement by $25, enter "25" as the amount

with the "Decrease" type selected. The system will calculate the new total of $75 automatically.



Best Practices for Financial Management

Regular Reconciliation

Schedule weekly or monthly

reviews of the Financial Tab to

ensure all reimbursements

and adjustments are

processed promptly. This

helps prevent backlogs and

maintains accurate financial

records.

Detailed Documentation

Always include comprehensive

notes in the memo fields when

creating financial entries.

These notes provide important

context for other users and are

invaluable during audits or

financial reviews.

Strategic Filtering

Use the "Show" dropdown

effectively to focus on specific

transaction types when

reviewing financial data. This

targeted approach improves

efficiency when handling large

volumes of transactions.

Access Control

Limit financial management

permissions to appropriate

staff members. This maintains

financial data integrity and

ensures only authorized

personnel can create or modify

financial records.



Getting Additional Support

Search Related Articles

Browse the knowledge base for

additional financial management articles

at the bottom of each help page under

"Related Articles"

Contact Support Team

Email support@extendedreach.com with

specific questions or issues that aren't

addressed in the documentation

Explore Enterprise Financials

For organizations without the Enterprise

Financials add-on, contact

sales@extendedreach.com to request

information or schedule a demo

Request Training

Arrange specialized training sessions for

your team to maximize your use of the

Financial Tab features

extendedReach is committed to ensuring you get the most out of the Enterprise Financials add-on. Our support team is ready to assist

with implementation questions, troubleshooting, or advanced usage scenarios. Don't hesitate to reach out when you need guidance on

optimizing your financial workflows.



Family Web Tab Overview

Accessible via Home Screen

Located in the household section for specified provider types

Customizable Access

Control which provider types can access the Family Web through Organization

Preferences

Family Communication Hub

Centralized location for all family-related communications and updates

Technical Support

Contact support@extendedreach.com for assistance with enabling or troubleshooting

The Family Web Tab serves as a central communication platform between your agency and

foster families. If you don't see this feature, it may need to be enabled for your agency. The tab's

layout is designed to be intuitive, providing quick access to posts, activities, and the family

website view.



Understanding the Posts Tab

Comprehensive Activity View

The Posts tab displays all communications and activities that occur within the Family Web

environment, creating a chronological record of interactions between agency staff and foster families.

This transparency ensures that all team members can stay informed about family communications,

reducing the risk of missed information or duplicated efforts.

Messaging Capability

Initiate direct communication with foster families by clicking the "Post a Message" button. This feature

allows you to share updates, reminders, or important information that will be immediately visible to the

family when they log in.

The Posts tab is your window into all Family Web communications. Here you can view the complete history of interactions and send new messages to families. This centralized communication helps maintain

consistent information flow and strengthens the relationship between your agency and foster families.



Sending Messages to Families

Navigate to Posts

Tab

From the Family Web Tab

in the household's Home

Screen, select the Posts

tab to view all current

communications.

Click "Post a

Message"

This button opens the

message creation interface

where you can compose

your communication to the

family.

Compose and Send

Write your message,

review for clarity and

professionalism, then send

it to make it immediately

available to the family.

Track Engagement

Monitor when families view

your messages to ensure

important information has

been received.

Effective communication with foster families is essential for successful case management. The messaging feature allows you to

maintain regular contact, share timely updates, and address concerns promptly. Remember that all messages become part of the

permanent record, so maintain professional communication standards at all times.



Managing Family Web Activity

Send Invitation

Initiate family access by sending email invitations with setup

instructions

Family Registration

Families create accounts and access their personalized web

portal

Ongoing Communication

Regular information sharing between agency and family

Activity Monitoring

Track engagement and participation through the Activity tab

The Activity tab is where you'll manage family access to the web portal. The "Send Invitation" feature generates an email with instructions for setting up their account. This tab also allows you to track

which family members have registered and their level of engagement with the platform.



Inviting Families to the Web Portal

Preparation Steps

• Verify family email addresses

are current in the system

• Ensure the family's provider type

has been granted access

• Consider preparing families with

a phone call before sending the

invitation

Invitation Process

• Navigate to the Activity tab in the

Family Web section

• Click the "Send Invitation" button

to generate the email

• System sends detailed

instructions to the family's email

address

Follow-Up Actions

• Check the Activity tab to confirm

if invitations have been opened

• Contact families who haven't

registered after a week

• Offer technical assistance to

families experiencing difficulties

Properly introducing families to the Family Web portal is crucial for successful adoption. Take time to explain the benefits of using

the platform, such as improved communication, easier document sharing, and faster response times. Consider creating simple

handouts with visual instructions to supplement the email invitation.



Viewing the Family Perspective

Family Dashboard View

Access the family's perspective by clicking

"View Family Website" in the Posts tab. This

allows you to see exactly what the family sees

when they log in, helping you provide better

guidance and support.

Family User Experience

Understanding the family's user interface helps

you anticipate questions and troubleshoot

issues more effectively. The family view

includes notifications, messages, document

access, and other features designed for their

specific needs.

Training Opportunities

Use the family view during orientation sessions

to demonstrate the platform's functionality.

This hands-on approach increases comfort

levels and encourages consistent usage of the

communication tool.

Experiencing the Family Web from the family's perspective is invaluable for providing effective support. This view allows you to identify potential

confusion points, verify that information displays correctly, and better understand the family's interaction with your agency. Consider scheduling

virtual training sessions to walk new families through the interface.



Key Takeaways and Next Steps

Enhanced Communication

Streamlines information sharing between agencies and families

Complete Documentation

Creates permanent records of all family interactions

Improved Family Engagement

Increases family participation in the care process

Time Efficiency

Reduces phone tag and administrative overhead

The Family Web Tab transforms how your agency connects with foster families, creating a more responsive and transparent relationship. As you implement this

tool, start by identifying several families who would benefit most from this communication channel, then gradually expand adoption agency-wide.

Remember that consistent usage by staff is key to successful implementation. Consider designating "Family Web champions" within your team to help colleagues

integrate this tool into their daily workflows. For additional support, contact ExtendedReach at support@extendedreach.com.



Comprehensive Guide to

Tracking Adoptive Homes in

extendedReach

Welcome to this comprehensive training on managing adoptive homes within

the extendedReach platform. This presentation will guide agency staff

through the complete process of tracking adoptive homes—from initial

application to closing. You'll learn efficient navigation techniques, key

features, and best practices that streamline your workflow.

We'll explore the system's capabilities to help you maintain accurate records,

monitor applicant progress, and ensure compliance with adoption

requirements. Let's begin with understanding how to properly establish and

track adoptive homes in the system.

EP
by Emily Parks



Setting Up An Adoptive Home Record

Initial Setup Process

Creating a new adoptive home record requires specific actions to ensure proper

categorization in the system. First, navigate to the home creation screen where you'll

find various home type options.

The key step is checking the "Adoptive Home" checkbox, which activates adoption-

specific fields and tracking capabilities. This designation ensures the home appears

in adoptive home reports and dashboards.

Date Documentation

After designating the home type, you must select the Adoption Application date using

the calendar icon located on the right side of the input field. This timestamp

establishes when the formal application process began.

The application date serves as a reference point for timeline tracking, deadline

management, and compliance reporting. Accurate dating is essential for regulatory

requirements.



Accessing Home Rosters

Navigate to Home Rosters

Begin by locating and clicking on the "Home Rosters" option in the

main navigation menu. This section contains all home management

functions.

Select Adoptive Homes

From the dropdown menu, choose "Adoptive Homes" to filter the

roster specifically for adoption-designated households.

Review Complete Roster

The system displays all currently open adoptive homes in your

agency, allowing for comprehensive oversight and management.

The Home Roster view provides a centralized location to monitor all active adoptive

homes. This interface allows staff to quickly assess status, capacity, and key

metrics across your entire adoptive home portfolio.



Managing Home Adoption

Applications

Access the Intake Menu

Begin by clicking on the "Intake" option in the main navigation menu. This section

handles all incoming applications and referrals.

Select Home Adoption Applications

From the dropdown menu, choose "Home Adoption Applications" to view all

homes that have submitted formal adoption applications.

Review Application Queue

The resulting screen displays all pending applications with status indicators

and next action requirements.

This view provides a comprehensive overview of all homes in various stages of the

application process. Social workers can efficiently track which applications need attention,

identify bottlenecks, and ensure timely processing of all adoption applicants.



Tracking the Home Study Process

Initial Documentation

Track receipt of background checks, financial statements, and references through the

Documents tab.

Home Visits

Schedule and document home inspection visits using the Calendar and Notes features.

Home Study Completion

Upload the completed home study document and update status to "Home Study

Approved."

Final Approval

Record final approval dates and update the home's placement availability status.

The home study process requires meticulous documentation and milestone tracking. ExtendedReach

provides integrated tools to ensure each step is properly recorded, creating a complete audit trail from

initial application through final approval.



Matching Children with Adoptive Homes

Identify Potential Matches

Use the matching tool to find

compatible children based on home

preferences and capacity.

Initiate Introductions

Document initial meetings, visits, and

interactions between child and

prospective family.

Placement Period

Record the placement and track

required supervisory visits during the

pre-adoption period.

Finalization

Document court dates, legal

processes, and adoption finalization

details.

The matching process represents the heart of adoption work. ExtendedReach provides tools to identify potential matches based

on the specific needs of the child and the capabilities of the adoptive home. The system maintains detailed records of each step

in the matching and placement process.



Closing an Adoptive Home

Navigate to Home Status

Locate the home record you wish to close and click on the "Status" dropdown

menu in the home profile.

Select Discharge Option

Choose "Discharge" from the dropdown menu to initiate the closure process for

the adoptive home.

Complete Required Fields

In the pop-up window, enter all mandatory information including discharge

reason, date, and any additional notes about the closure.

4 Submit and Confirm

Click "Submit" to finalize the home closure and update its status in the system

database.

The process for closing adoptive homes mirrors that of foster homes. Note that your organization can customize discharge reasons through Organization Preferences, allowing

for adoption-specific closure categories that better reflect your agency's workflow and reporting needs.



Best Practices & System Optimization

Regular Data Audits

Conduct monthly reviews of adoptive home records to ensure

completeness and accuracy. Look for missing documentation,

outdated information, or incomplete status updates that might

affect reporting or compliance.

Custom Report Creation

Develop specialized reports for adoptive homes to track key

metrics like time-to-placement, successful matches, or homes

nearing license expiration. Use the Reports module to save and

schedule these reports for regular distribution.

Integration with Other Modules

Maximize efficiency by utilizing connections between the Adoptive

Homes module and other system components like Case

Management, Billing, and Document Management for a

comprehensive workflow.

User Training

Ensure all staff receive thorough training on adoptive home

tracking features. Consider designating super-users who can

provide ongoing support and training to new staff members.

Implementing these best practices will enhance your agency's ability to efficiently manage the adoption process. Remember that support is always

available at support@extendedreach.com  for any questions not covered in this presentation. Regular system usage reviews and staff training

sessions will ensure your team maximizes the benefits of extendedReach's adoptive home tracking capabilities.



Enabling Texas GPS

Integration for Foster Care

Data Transfer

Welcome to this comprehensive guide on enabling the Texas GPS data

collection integration in extendedReach. This powerful feature allows

Texas child welfare providers to seamlessly transfer placement criteria

and vacancies to the Texas Department of Family and Protective

Services General Placement Search (GPS) System.

Through this presentation, you'll learn the complete process from

enabling the integration to configuring contacts and managing field

requirements. Let's ensure your organization meets state requirements

while streamlining your data submission process.

EP
by Emily Parks



Integration Overview and
Benefits

Real-time Data Transfer

All data entered into extendedReach is automatically sent to the GPS system

as it's saved, eliminating manual reporting.

Compliance Assurance

Meet Texas Department of Family and Protective Services requirements for

placement criteria and vacancy submissions.

Streamlined Workflow

Reduce administrative burden by entering data once in your familiar

extendedReach environment.

Time Efficiency

Save valuable staff time by eliminating duplicate data entry across multiple

systems.



System Prerequisites

Texas Implementation

Your extendedReach system must be configured for Texas

Administrator Access

User must have Full Administrator permissions

Updated System

Running latest extendedReach version

Before beginning the integration process, verify you meet all system requirements. The Texas GPS integration requires your

extendedReach implementation to be specifically configured for Texas child welfare operations. Additionally, you'll need full

administrator permissions to access the necessary configuration settings.



Enabling the GPS Integration

Access Administration Panel

Navigate to your workspace and select the Administration Menu

Enter System Settings

Locate and select the System Settings option

Find GPS Integration Option

Scroll to find "Homes: Enable Texas GPS data collection"

Activate the Feature

Check the box to enable the integration



System Changes After Activation

Home Files Updates

GPS Identification section appears on

the General tab

New GPS Criteria Tab

Dedicated tab for entering and

managing GPS criteria

Case File Updates

Anticipated Discharge field becomes

required

Real-time Data Transfer

Data automatically syncs with Texas

GPS system

After enabling the GPS integration, you'll notice several changes to your extendedReach interface. The system will display new

fields and tabs designed specifically for GPS data collection. Most importantly, the Anticipated Discharge field becomes required

for all case files to ensure compliance with state reporting requirements.



Managing Anticipated Discharge Field

Requirements

Navigate to Program Settings

From your workspace, access

Administration Menu, then select Program

Settings followed by Programs to view all

available programs in your system.

Modify Field Requirements

For programs not reporting to GPS,

uncheck the Anticipated Discharge

requirement box to remove this field

constraint from non-GPS programs.

Save Your Changes

After making your selections, be sure to

save all changes to apply the updated

field requirements across your system.



Configuring GPS Integration Contact

Information

Primary Contact

Designate a staff member who will serve as

the main point of contact for GPS-related

communications from the Texas Department

of Family and Protective Services.

• Must be an active staff member

• Should have knowledge of placement

processes

• Will receive system notifications

Secondary Contact

Identify a backup contact person who can

address GPS inquiries when the primary

contact is unavailable.

• Ensures continuous communication

• Receives notifications when primary is

absent

• Should have similar system knowledge

Technical Support

Add a technical contact who can troubleshoot any integration issues that might arise with the

data transfer.

• May be IT staff or system administrator

• Receives error notifications

• Coordinates with extendedReach support



Next Steps and Support Resources

Verify Configuration

Double-check all settings and ensure the GPS identification sections appear correctly in

your system.

Train Staff

Provide training on the new GPS fields and requirements to all relevant staff members.

Populate GPS Criteria

Begin entering placement criteria and vacancy information for all applicable homes.

Contact Support

Reach out to extendedReach support with any questions or issues during

implementation.

After completing the integration setup, focus on training your team and populating the system with

accurate placement data. Remember that extendedReach support is available to assist with any

technical questions during your implementation process. For Texas-specific questions, contact your

regional DFPS representative.



Texas GPS Integration Data

Point Fields - Home File

(Foster Care)

This article will give an overview of the data point fields for the Texas

Department of Family and Protective Services General Placement

Search (GPS) integration within the home file.

With Texas CPS providers being required to submit placement criteria

and vacancies to the (GPS) we offer an electronic data transfer (EDT) of

GPS data through extendedReach. Data entered into extendedReach will

be sent to GPS in real-time as it is saved.

EP
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Prerequisites for Texas GPS Integration

Texas GPS Integration enabled

Follow the guide: Enabling Texas GPS Integration (Foster

Care)

User Permissions

An extendedReach User ID with the Edit Homes permission

https://er1.extendedreach.org/hc/en-us/articles/28952589592987-Enabling-Texas-GPS-Integration-Foster-Care
https://er1.extendedreach.org/hc/en-us/articles/28952589592987-Enabling-Texas-GPS-Integration-Foster-Care
https://er1.extendedreach.org/hc/en-us/articles/28952589592987-Enabling-Texas-GPS-Integration-Foster-Care
https://er1.extendedreach.org/hc/en-us/articles/28952589592987-Enabling-Texas-GPS-Integration-Foster-Care
https://er1.extendedreach.org/hc/en-us/articles/28952589592987-Enabling-Texas-GPS-Integration-Foster-Care
https://er1.extendedreach.org/hc/en-us/articles/28952589592987-Enabling-Texas-GPS-Integration-Foster-Care


Home File: General Tab - GPS Identification

Facility

For homes that do not need to send data to GPS there is the No option. For those that do, there is the Yes option. When Yes is selected the Facility ID field will be required. The checkbox is available for home that fictive kin or kinship to

be filtered out of the GPS submission.

Facility ID

This ID is used to match the home record to its GPS record. This ID comes from the public provider portal where licensing information about the home is found.

Secondary

For homes that do not have secondary and QRTP contracts there is the No option. For those that do, there is the Yes option. When Yes is selected the Resource ID field will be required.

Resource ID

This ID is used to match the home record to its GPS record for secondary and QRTP providers.

ORR

For homes that accept children from ORR there is the Yes option. For homes that do not there is the No option.



Home File: GPS Criteria Tab - Summary

Key Components

Instruction Area

Message about who needs to or does not need to complete

this form/page.

Beds Area

Counts box displays the used beds, help beds (current

clients), borrowed beds, and bed holds count for the home.

Placement/Household Grid

Information is displayed including name, date of birth,

relationship, age, non-DFPS status, and anticipated

discharge for all placements and household members that

are not the Parent A or B.



Home File: GPS Criteria Tab - Placement Criteria

Identification

• Facility ID: Used to match the home record to its GPS record

• Resource ID: Used for secondary and QRTP providers

Capacity Information

• Maximum Capacity: For the home

• Gender(s) Accepted: For the home

• Minimum/Maximum Age Accepted: For the home

Vacancy Details

• Number of Vacancies: Based on capacity and bed count

• Number non-DFPS Children: As seen with placement

• Anticipated Vacancies: Based on discharge dates

• Anticipated Vacancy Date: From case file

Support Capabilities

• Preferences: Placement preferences for the home

• Supported Races, Languages, Religions

• Service Level and Specialized Services

• IQ Levels Accepted

• T3C credentials and service packages



Home File: GPS Criteria Tab - School Information

Search School Districts Can search for applicable school district in the search bar or from the list

Selected District Code Displays selected school district code

Elementary School Name Displays elementary school name pulled from the General tab of the home

Is Charter School (Elementary) Yes or No option for elementary school

Middle School Name Displays middle school name pulled from the General tab of the home

Is Charter School (Middle) Yes or No option for middle school

High School Name Displays high school name pulled from the General tab of the home

Is Charter School (High) Yes or No option for high school



Home File: GPS Criteria Tab -
Additional Information

Additional Placement Information

Text box to provide a place to type any additional placement information with a max

of 300 characters.

Synchronization Status

Last Attempted: Lists the time and date of last synchronization.

Status: Lists the status for the home, never, excluded, or success.

Response Details

For reason of status other than success.

This information helps track the synchronization process between extendedReach and the

Texas GPS system, ensuring data is properly transferred and any issues are identified.



Data Synchronization Process

Real-time Updates

Data entered into extendedReach is sent to GPS immediately when saved

Validation Process

System checks for required fields and proper formatting

Data Storage

Information is stored in both extendedReach and GPS systems

Placement Matching

Data enables efficient matching of children with appropriate homes

The Texas GPS Integration ensures that foster home information is accurately maintained across systems, improving placement efficiency and reducing

administrative burden. By automating data transfer between extendedReach and the Texas Department of Family and Protective Services General

Placement Search system, agencies can focus more on quality care and less on duplicate data entry.



Texas Provider Gateway

Content:

• Introduction and Initial Setup

• Testing the Connection

• TPG Home Report

• Additional TPG Settings
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Introduction and Initial Setup

extendedReach can automatically update Foster Home information on the Texas Provider Gateway (TPG)! This is done by matching

Foster Homes in extendedReach to homes on the TPG site using the homes "Resource ID" or "RID".

The interface will only transmit updated information for existing homes already on the listed on the TPG. The TPG requires that new

homes be created manually by a TPG user id first (vs. updated by extendedReach).

The "RID" is an identifying number assigned by State of Texas's IMPACT computer system. When a new home is added to the TPG, a

temporary RID is assigned by the TPG system until the official RID is assigned by the IMPACT computer system. The interface

between extendedReach and TPG works with both temporary RIDs and official (IMPACT) RIDs.

"SSCC" refers to the "Single Source Continuum Contractor" which is the lead contractor for a particular region in Texas. The TPG acts

as a data exchange between foster care agencies and the SSCC's.

Process to start TPG interface configuration:

1. Contact your SSCC's system administrator for the Texas Provider Gateway and ask that an "API User ID" be created and

added to your TPG account.

2. One the "API User ID" has been created, submit a support ticket to extendedReach asking that the TPG be enabled. Please

include the "API User ID" name and password in the support ticket.

3. extendedReach support will enable the TPG interface and RID tracking.

4. Your agency will then manually input the RID number on each home file (see image below).

The RID number will be viewable for all homes under the Home Roster > Licensed Homes view.



Testing the Connection

Enter RID Numbers

To test the connection between

extendedReach and TPG and confirm

the information sends correctly, enter in

the RID number for a few homes (not

all).

Access TPG Settings

Go to Organization Settings >

Organization Preferences > General

Tab. Scroll down to the Texas Provider

Gateway section.

Send Test Data

Click on "Send Data to TPG Now" (must

not be in Edit mode).

Set Up Scheduled Sync

If the information transfers properly, you

can go back and enter in the RID for the

remaining homes. You can also set up

a scheduled sync to TPG to send data

once a day at 6 PM CST.

To set up the scheduled sync, click on

Edit under Organization Settings >

Organization Preferences; go to the

General tab and the Texas Provider

Gateway section. Click on "Schedule at

approx 6 PM CST daily" then save.



TPG Home Report

Add/Configure New Home Report Type

Once you have the TPG / extendedReach link working successfully, you can add/configure a new Home Report Type to use the "TPG Resource Preferences"; these preferences will automatically transfer to the TPG.

Configure Custom Subform

When configuring the report, click on the Custom tab under the report settings and add "S_HOME_TPG_PREFS" (remove quotations) as the Custom Subform name. You should only use this subform in a single Home Report Type for the entire agency. (Don't

create different ones for different Provider Types).

Enable Family Website Access

Homes can fill out the TPG Resource Preferences form directly from the Family Website as well. To set up this configuration, go to the settings of the TPG Resource Preferences Home Report Type and click on Show Advanced Options in the configuration area.

Enable the setting "Foster Home initiated report using custom form (advanced)" then add "F_FRM_TPG_PREFS" (no quotations) as the Family Form name.

Verify Configuration

To verify that the report is set up properly, go to Organization Settings > Organization Preferences > General Tab. Scroll down to the Texas Provider Gateway section and check to see if it says "Configured" under the Resources Pref field. Clicking on the

hyperlinked "Configured" word will re-direct you to the report.

Once configured, it will send the TPG Preferences for each home that has it filled out to TPG.



Additional TPG Settings

Email copies of XML files

Sends copies of the transmitted and received files to the

"Email Errors To" email address. (Only meant for

Troubleshooting)

Transmit only for specific branches

Allows you to transmit TPG only for specific

branches/locations

Transmit first x homes

Transmit only the first 1, 5, 25, 50, or 100 homes to TPG

(Only meant for Troubleshooting) (homes are transmitted

in alphabetical order by home last name)

Transmit one home using RID

Transmit only a single home identified by Resource ID

(Only meant for Troubleshooting)

Congrats! You are all set up and ready to go with the TPG / extendedReach interface. If you have any questions or need

troubleshooting assistance with the TPG integration, please email support@extendedreach.com.

mailto:support@extendedreach.com


Foster Care - How do I

discharge a case?
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Initiating the Discharge

Process

Access Case Profile

Navigate to the case profile you want to discharge

Click Discharge Button

Find and click on the Discharge button

Select "Case"

Choose the "Case" option from the dropdown menu

To discharge a case, go to the case profile and click on the Discharge

button and select "Case".



Completing the Discharge Form

Disable Pop-up Blocker

Make sure your pop-up blocker is

disabled for extendedReach or else

you will not be able is discharge the

case.

Fill Required Fields

At minimum, fill in the yellow,

highlighted fields and then press Ok.

Submit Form

Press the Ok button to complete the discharge process.

A pop-up will then appear asking for additional discharge information -- make sure

your pop-up blocker is disabled for extendedReach or else you will not be able is

discharge the case.

At minimum, fill in the yellow, highlighted fields and then press Ok.



Confirming Case Discharge

Submit Discharge Form

Press the Ok button on the discharge information form

Wait for Screen Refresh

The system will process your request and refresh the page

Verify Discharge Status

Look for "Discharged" label next to the client's name

Once you press Ok, the screen will refresh and the case will say

"Discharged" next to the clients name.



Troubleshooting Missing

Discharge Button

Security Restrictions

Your agency may have security restrictions in place that prevent certain

users from discharging cases

Permission Levels

Different user roles have different levels of access to system functions

Contact Administrator

Reach out to your agency administrator for assistance with permissions

If you did not see the discharge button on the case screen, please contact your

agency administrator as they may have security restrictions in place that prevent

users from discharging cases.



Foster Care - How can I change the discharge

date, outcome, reason, or location?

If you have entered incorrect information when discharging a case, you can modify it using the "Reopen -> Modify Foster

Discharge" option.



Why do tasks keep showing up on my task list for discharged cases?

If a case has been discharged/closed and you are receiving notifications for tasks that are due after the discharge date, this is due to a setting not being configured on those activities or reports. 

To prevent repeat due dates for closed cases , go to the settings of a specific activity or report and make sure that “Delete if due after close date and case closed (stop repeating)” is checked: 

Once this change is made, a system administrator will need to delete any of the Due activities/reports that appeared after the close date. 



Foster Care - Closing an Adoption Case

This presentation will guide you through the process of closing cases in the extendedReach system, covering the following

topics:

• Introduction

• Closing a Foster Care Case

• Closing an Adoption Case

• Finalization/Disruption Date

• Changing Discharge Information
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Introduction

Purpose

This article is meant to assist you with closing case in the

extendedReach system.

Additional Support

If you have a question not addressed here, you can contact support at

support@extendedreach.com



Closing a Foster Care Case

Access the Discharge Menu

From a case file, hover over the "Discharge"

button in the action bar and click on "Foster

Care Case" from the drop-down menu.

Note: this option is not available for all users. If

the Discharge button is not available, please

contact your agency administrator to discharge

the case for you.

Complete Required Fields

Complete the fields and click OK.

Field Descriptions

View NameDescriptionDischarge All

SiblingsSelect "yes" or "no" from the drop-down

menu.OutcomeIndicate the outcome/reason for

the discharge from the drop-down

menu.Discharge TypeSelect "successful",

"unsuccessful", or "emergency" from the drop-

down menu.Discharged ToFamily or facility the

case was discharged to.Contact NameName of

the best contact at the facility or household (if

applicable).AddressAddress of the family or

facility the case was discharged to.

http://to.Contact


Closing an Adoption Case

Access Discharge Menu

From a case file, hover over the "Discharge" button in the action bar and click on "Adoption Case" from the drop-down menu.

Complete Required Fields

Complete the fields and click OK.

Field Descriptions

View NameDescriptionDischarge All SiblingsSelect "yes" or "no" from the drop-down menu.OutcomeIndicate the outcome/reason for the discharge.Finalization OrderedType in the date, or click on the calendar icon to select the date, when finalization was

ordered.



Finalization/Disruption Date

Setting the Date

Type in the date, or click on the calendar icon to select the date,

when finalization was ordered.

Disruption Indicator

Place a check-mark in the box next to "Adoption was disrupted" if

this is the case.



Changing Discharge Information

Access Case File

Navigate to the case file you need to

modify

Find Reopen Button

Hover over the "Reopen" button in the

action bar

Select Action

From the drop-down menu, click on the

action you wish to change

Complete Changes

Make your modifications and save



T3C Required Tracking



Preparing eR for T3C

to Meet Reporting Requirements
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Prerequisites and System

Requirements

1 Texas Foster Care/Residential System/GCM

System

Must have an active Texas Foster Care or Residential system

already configured in extendedReach

2 Full Administrator Permissions

Requires an extendedReach User ID with Full Administrator user

permissions to access configuration settings

3 System Evaluation Readiness

Prepared to assess current feature usage and determine

configuration needs for T3C compliance



Program Categories and Custom Fields Configuration

Program Categories Assessment

Review your ability to add program categories and subcategories for both legacy and

T3C requirements. If possible, add categories for credentialed service packages and

update existing program reports to include new categories.

Custom Fields Evaluation

Examine current program custom field usage and availability. Determine if you have

sufficient extra fields to accommodate T3C requirements, or if a new program

addition is necessary.

Subcategory Formula
@If(CC_Category="Treatment Services";"ED (Emotional Disorder) |
ED":"ID (Intellectual Disability) | ID":"ASD (Autism Spectrum Disorder) |
ASD":"PMN (Primary Medical Needs) | PMN":"TV (Trafficking Victim) |
TV";CC_Category="T3C - Basic Foster Family Home Support Services":"T3C
- Short-Term Assessment Support Services":"T3C - Mental & Behavioral
Health Support Services":"T3C - Complex Medical Needs or Medically
Fragile Support Services":"T3C - Intellectual or Developmentally Disability
(IDD)/Autism Spectrum Disorder Support Services":"T3C - Treatment
Foster Family Care Support Services";"A. Transition Support for Youth and
Young Adults":"B. Kinship Caregiver Support":"C. Pregnant and Parenting
Youth":"D. None":"Treatment Services: ED (Emotional Disorder) |
ED":"Treatment Services: ID (Intellectual Disability) | ID":"Treatment
Services: ASD (Autism Spectrum Disorder) | ASD":"Treatment Services:
PMN (Primary Medical Needs) | PMN":"Treatment Services: TV
(Trafficking Victim) | TV";"")
• Formula is plug and play. Just change the words inside the parenthesis

“xxx”, or add a colon and new parenthesis to add legacy options.



Referral Tracking and Respite Management

Referral System Setup

Enable referral tracking if not currently active and add necessary denial reasons for T3C compliance. 2 Places in eR to

configure:

Uncheck box below

Program Settings > Setup Tab

Org Settings > Org Preferences > Settings Tab

Reporting Configuration

Configure reporting for pending and rejected referrals to maintain comprehensive tracking

Respite Home Tracking

Ensure respite tracking covers both legacy and T3C placements with appropriate payment configurations

-Rates for legacy and T3C in Programs > Program Rate Sheets

Org Settings > Org Prefs > Settings > Scroll down and select.

May need a zero-dollar rate for when Homes have more than 40 hrs-respite/year.



Foster Parent Training and Provider Types

Training Hours Configuration

Configure Foster Parent Training Hours to meet

both legacy and new T3C requirements. Custom

formulas available through Customer Success

Manager if needed.

Provider Type Matching

Add provider types that align with credentialed

service packages for T3C. Update existing home

reports and Foster Family Website access

accordingly.

License Type Updates

Establish license types that correspond to T3C

service packages and update home reports with

new license triggers.



Organization Custom Fields

and License Management

1 Field Assessment

Evaluate current organization and program custom field

usage and available capacity for T3C additions

2 License Configuration

Add license types matching T3C service packages and

update associated reports

3 System Integration

Ensure all new configurations work seamlessly with existing

home reports and activities



ExtendedReach Support Services

Funding

Organizations

Email Support to add required funding

organizations to your T3C programs.

These will be your SSCCs you contract

with

Enterprise Financials

Contact Customer Success

Manager for T3C enterprise

financial setup assistance

Rate Sheets & Reports

Custom import services for

service package rates and

Zoho report templates for

outcome tracking

Revision Tracking

Email Support to ask what

revisions are currently enabled

in your system. Revisions

enable date tracking for case

and home file changes required

for T3C compliance. ex.

Categories, subcategories,

custom fields

Revisions

Any field in eR can have a

revision date added. Revisions

allow you to backdate when a

particular field changes. eR will

track all revisions under the

Case File and Home File Tab

(sort by revisions)



Implementation Decision
Framework

Evaluate Current Capabilities

Review each feature against T3C requirements using the provided assessment

questions. Determine if existing configurations can accommodate new needs or if system

expansion is necessary. Whispering Pines Consulting can help evaluate your system for

efficiency.

Configure or Expand

If current features are sufficient, proceed with configuration using linked help articles.

If not, consider adding new programs or organizations while consulting with your

Customer Success Manager.

Implement and Monitor

Execute chosen configuration strategy, ensuring all T3C requirements are met

while maintaining efficient record tracking. Utilize extendedReach support

services as needed for specialized implementations.



Logic Models and Outcome

Measurement

Bolded outcomes should be incorporated into Logic Models - but how to

define/measure will be specific to each agency - below are some internal

eR report examples:
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Safety Outcome Measurement

Casework -> Incidents -> By Type Abuse/Neglect

Track and measure incidents categorized as abuse or neglect to ensure safety standards

are maintained.

Casework -> Incidents -> By Type -> Restraints

Monitor the frequency and circumstances of restraint usage to minimize restrictive

interventions.

Casework -> Incidents -> By Type -> Injury

Document and analyze injury incidents to identify patterns and implement preventative

measures.

Casework -> Placements -> By Subsequent Placement

Evaluate placement stability and transitions to ensure safe and appropriate environments.



Permanency Outcome

Measurement

Discharge

D/C Outcome = Permanency Goal

Discharge -> D/C Outcome = Permanency Goal



Well-Being Outcome

Measurement

Specific Activities Completed

Medical, Dental, Therapy, etc.

Compliance with Healthcare Appts.

Tracking attendance and follow-through with scheduled

appointments

Service Plan Goal Progress

Tx Tab -> Casework -> Treatment Goals or Zoho



Implementation

Requirements

Required Documentation

Also - ensure that agencies are using the TX Single Child Plan of

Service custom form. Reach out to your Customer Success

Manager to copy the custom form into your system. It comes field

coded

Consistent Reporting

Maintain standardized documentation practices across all cases

Regular Updates

Keep service plans current with client progress and changing needs



extendedReach Side Menu for Reports

Organization

extendedReach is organized in a manner that allows you to easily access information.

Your workspace is customized to meet your specific needs based on your role within your agency.

The Side Menu, however, provides comprehensive agencywide data, accessed through "Views".

Permissions

Depending on your User ID permissions, some of these views may not be

viewable for you. Please contact your agency administrators for permission to

access those views.

The Administration tools are restricted to administrative use only.

My Stuff

• My Workspace

• My Tasks

• Cases

Case Management

• Case Rosters

• Case Tasks

Home Management

• Homes

• Home Rosters

• Home Tasks

• HomeMatch™

Reporting

• Summaries

• Dashboard

• Casework

• Demographics

• Intake

• Discharge

• Staff

• Resources

Administration

• Organization Billing

• Organization Settings

• Program Settings

• System Settings



Zoho Reports

Third-Party Integration

Zoho Reports (http://reports.zoho.com) is a 3rd party custom report and dashboard builder available as an optional add-on item.

Availability

If your agency doesn't currently have this option and you are interested in learning more, please contact sales@extendedreach.com.

Functionality

Zoho Reports allows an administrator to quickly build charts, tables, and dashboards using an intuitive drag-and-drop interface. Once your reports are built, you can

choose to add them to the side-menu in extendedReach and share with others in your agency. Zoho reports is restricted to administrative use only; publishing the

reports to the side-menu allows all staff to view the report.

http://reports.zoho.com/
mailto:sales@extendedreach.com


Access Rights Configuration

Security Rights Navigation

Access to the side menu reports is given in the User ID or User Group > Security Rights >

Navigation

Menu Access Options

• Access Case Menus

• Access Home Menus

• Access Summaries Menus

• Access Summaries (Staff & Resources)

• Access Summaries (Resources Only)

Group Configuration

Group Name: Caseworkers

Organization: Enchanted Family Services

Description: Child case worker

Permission Settings

Administrator: No

Security rights include options for Add, Delete, Edit, Approve, and Complete permissions for various

modules



Side Menu Actions

Filter by Branch

• Select a specific branch to filter records

• To view all branches, select "Show All Branches"

Export Data

• Click the "Excel" button on the top menu bar to download, and you will be prompted to open the file

Organize Information

• Click the "Group" button on the top menu bar to group data in a variety of ways

• Click the plus or negative icons one by one, or

• Click "Expand All" button to expand everything at once

Note: You may see different naming for reports depending upon your agency configurations and programs (Foster Care, Adoption, Residential, etc.)



Cases > Case Rosters

Open Cases

Foster Care Cases Open Cases (may also appear as

"Residential Cases")

Adoption Cases

Open Adoption Cases, if applicable to agency

Referrals

All pending and accepted referrals

All Cases

All Cases (Open + Closed)

Anticipated Discharge

All Cases with an anticipated discharge date entered on case general tab

BMI Trends

If your agency records changes in a child's height and weight (BMI) over time the last two

measures will appear here along with a comparative calculation and any active

medications.

Medications

Medications recorded for Open Cases



Cases > Case Rosters (Continued)

Next Court Date

Open cases that have Next Court Date on General Tab

Next Medical Exam

Open cases that have upcoming medical appointments (can Group by Medical/Dental/Psychological/etc.)

Rates by Expiration

Open cases that have a Rate Expires Date on General Tab

Scheduled Placements

Open cases that have one or more placements scheduled at a future date

Monthly

Census by Worker

Number of Open Cases an Agency Case Worker has assigned to them in a particular

month or in total over a year

Monthly

Census by Program

Number of Open Cases in a Program in a particular month or in total over a year

Daily

Census by Program

Number of Open Cases in a Program on a particular day or in total over a year



Cases > Case Tasks

Due Soon/Past Due

All activities/reports due soon or past due

Compliance Tracking

All cases along with the items on the compliance tab that are either completed, overdue, or due soon

Daily Activity Summary

Completion status of select daily program activities; setting under organization preferences; identify

activities or reports as daily activities in configurator

Workflow Status Reports

• In Process items in the process of being completed

• Awaiting Approvals items awaiting approval from a supervisor in order to be marked as complete

• Awaiting External Signatures (package specific) items awaiting external signatures

• Awaiting Review items awaiting review

• Rejected items rejected by approving person and returned to form creator



Homes > Home Rosters

Open Beds

Licensed Homes that have beds available for cases

Licensed Homes

All licensed Homes

Applicants

Homes that are not licensed and/or in the application stage

Adoptive Homes

All adoptive homes

Inquiries

Homes inquiring about becoming licensed

Other Residences

Residences including Residential, Detention Facilities, Hospitals, Independent Living, etc.

All Homes (Open + Closed)

All open and closed Homes

Anticipated Approval

Applicant homes that are anticipating their approval to become licensed Homes



Homes > Home Rosters (Continued)

Family Website Status Homes that have either been invited or not invited to access their Family Website

Households All Households which can be applicants, approved homes, etc.

Last Placement Date Chronological order of recent placements (in or out)

License Variances Any license variances with expiration dates

Licensed Home Investigations Homes under investigation

Additional Home Reports

• Licensed Homes on Hold - All licensed homes put on hold

• Training Registrations - Homes that have registered for training

• Training YTD (Open Homes) - Year to Date training that has been attended and completed by all homes

• Monthly Census by Worker - Workers' homes by year and month



Homes > Home Tasks

Due Soon/Past Due

All activities/reports for a Home that is due soon or past due

Compliance Tracking

All Homes along with the items on the compliance tab that are either completed, overdue, or due soon

Daily Activity Summary

Completion status of select daily home activities (Residential programs)

Workflow Status

• In Process - Items that are in the process of being completed

• Awaiting Approvals - Items that are awaiting approval from a supervisor to be marked as complete

Document Status

• Awaiting External Signatures (package specific) - Items awaiting external signatures

• Rejected - Items rejected by approving person and returned to form creator



Summaries > Demographics

Cases Demographics

Cases segments and groups by:

• Age

• Gender

• Language

• Race

• Religion

Homes Demographics

Homes segments and groups by:

• Age

• Gender

• Language

• Race

• Religion

0-2 years 3-5 years 6-9 years 10-13 years 14-17 years 18+ years



Summaries > Intake

156

Referrals

# of referrals by year

98

Cases

# of cases by year

42

Homes Inquired

# of Homes that submitted inquiries

each year

28

Homes Licensed

# of Homes licensed each year

Case Analysis

• Cases by Reason - # of cases and referral reasons

• Prior Episodes - # of prior admissions and discharges for a case

each year

These reports help agencies track the flow of new cases and understand

the common reasons children enter care, allowing for better resource

planning and identification of community needs.



Summaries > Discharge

Denied Referrals

# of rejected referrals by reason

Cases

# of cases discharged each year

Outcomes

# of cases discharged for specific reason each year

Avg # of Caseworkers

Average # of caseworkers for a case

1 Avg # of Days in Care

Average # of days spent in care

2 Avg # of Placements

Average # of case placements

3 Homes

# of closed Homes each year

4 Home by Reason

# of closed Homes sorted by reason



Summaries > Staff

Directory

Provides a list of staff profiles

Training

Lists trainings and relevant training hours completed by staff

Events + Expirations

Lists expiration date of trainings for staff

Compliance Tracking Lists compliance activities that are missing or completed by staff

NOTE will cover in Staff Management Session.



Summaries > Resources

Address Book

Includes contact information for commonly used doctors, attorneys, dentists, therapists,

social workers, etc. among cases

• Quick access to important contacts

• Centralized directory for all staff

• Searchable by profession or name

• Regularly updated with current information

Shared Forms + Files

Centralized library of documents and forms that can be used throughout the organization

and shared among cases and homes

• Standardized agency forms

• Policy and procedure documents

• Educational resources

• Training materials



Support Resources

QUESTION & ANSWER



Program Settings - Program

Setup

This presentation covers the various program settings and setup options

available in extendedReach. We'll explore activity shortcuts, appointment

defaults, program setup options, and customization features to help you

configure your programs to meet your agency's specific needs.
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Introduction

Program Configuration

Each program is uniquely

configured to meet your

agency's needs. You can

locate additional settings to

disable or enable under

Program Settings.

Getting Started

Select the program you want

to apply the changes to, then

click on Edit to get started.

Many of the settings will be

available under the Setup tab.

New Program Setup

Please note that the following information is to modify existing

programs. If you wish to set up a new program, please contact

sales@extendedreach.com.

mailto:sales@extendedreach.com


Activity Shortcuts

Shortcut #1

Select the first activity

type to be readily

accessible on your

workspace

Shortcut #2

Select the second

activity type to be readily

accessible on your

workspace

Icon #1

Choose the image that

will be associated with

the first shortcut

Icon #2

Choose the image that

will be associated with

the second shortcut

Activity shortcuts allow for two activities to be readily accessible on your

workspace.



Initial Appointment Default Activity Type

Select Default Activity

When an appointment is created, you

can have a specific activity default as the

activity type. Select the activity from the

activity drop-down.

Add New Activities

If you would like to add an activity to this

list, go to Program Settings > Program

Activity Types to create a new activity.

Apply Settings

Save your changes to ensure the default

activity type is applied to all new

appointments in this program.



Program Setup

Enable/Disable Features

The Program Setup section is where you can enable or disable features for a particular program.

Place a checkmark next to the settings you wish to enable and click on Save.

You can enter a keyword into the Filter settings box to display a list of related settings. See the

screenshot of the Program Settings. Notice how the settings below the Filter Settings block all

contain the work "track" in them because the user entered "track" into the Filter Settings block.

Available Settings

Below is a description of the settings available. Please note that the "Financial", "Insurance", and

"Authorization" settings may be unavailable for your agency as they require the Enterprise

Financials. If you are interested in using Enterprise Financials, please contact

sales@extendedreach.com.

Settings include options for compliance checklists, tracking program categories, admission types,

discharge types, worker assignments, custom labels, and many more configuration options.

https://er1.extendedreach.org/hc/en-us/articles/14922536960923
https://er1.extendedreach.org/hc/en-us/articles/14922536960923
mailto:sales@extendedreach.com


Setup

Drop-down Lists

Add or remove drop-down list items

Field Labels

Change the label of certain fields within extendedReach

Compliance Checklist

Add items to the compliance checklist

Categories

Configure admission types, relationship types, and treatment goal categories

Under the setup section, you can customize various aspects of your program to match your agency's workflow and terminology.



Outcomes

Successful Outcomes

Define positive case closure results

Unsuccessful Outcomes

Define negative case closure results

Discharge Types

Configure various discharge categories

Outcomes are selected when a case is closed/discharged. Here you can add the list of successful outcomes or unsuccessful outcomes as well as discharge types. To track the discharge types, the setting "Program: Track

discharge types" must be enabled.



Referrals

Referral Reasons

Modify the list of reasons why clients are referred to your program

Referral Sources

Configure the list of organizations or individuals who refer clients

Referral Services

Define the types of services clients can be referred for

Rejection Reasons

Specify reasons why referrals might be rejected

If your agency is tracking referrals, you can modify selections for the referral

reasons, sources, services, and reasons the referral was rejected. If these options

are not available and you would like to start tracking referrals, go to System Settings

> System Configuration > disable the setting "Referrals: Don't track referrals".



Required Case Fields

Mark Required Fields

Select which fields must be completed

Case Editing

Staff must complete all required fields

Data Validation

Ensures complete case information

The fields in this section can be marked as required. When a staff member is editing the case, they would be required to fill in the fields that are marked with a check mark.



Invoice Customization

Customize Remit Payment Area

Modify the payment recipient information

Enter Payment Details

Use the text field to enter recipient information

Apply to Invoices

Changes will appear on all program invoices

Invoices can have their "remit payment to" area modified. Use the text

field to enter in the name of the individual or organization for payment to

be remitted to.



Organization Preferences -

Settings

This presentation provides details on the Settings Tab in Organizational

Preferences, which serves as the configuration control center for your

agency's extendedReach system. You'll learn how to assign custom options

that affect how your agency works with eR.
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Introduction

Purpose

This article is meant to provide you with details on the Settings Tab

in Organizational Preferences. Organizational Preferences is the

configuration control center for your agency's extendedReach

system.

Function

The Settings Tab is where you will assign custom options that will

affect how your agency will work with eR.



Prerequisites

Administrator Access

You must be an Agency Administrator to access the "Administration"

menu on the left side of your Workspace.

Navigation

Hover over Organization Settings and click on "Organizational

Preferences".



Overview

Configuration Hub

The Organizational Preferences screen serves as your central

configuration hub

Multiple Settings

Contains various tabs for different aspects of system configuration

Agency-Wide Impact

Changes made here affect all users in your agency



General Settings

Setting Description

Automatically assign case #'s New cases added to the system will automatically be assigned a case number - here you can see what the next

case number will be as well as change the prefix of the number.

Automatically assign customer #'s Option to assign customer numbers from a different "counter" than the case number counter. (or just keep

customers the same as case #) (or just leave customer #'s left blank) (or just hide customer #'s)

Automatically assign home #'s New homes added to the system will automatically be assigned a home number - here you can see what the

next home number will be as well as change the prefix of the number.

Keep same case # on readmission If a case is closed and then re-admitted, it will keep the original case number.



Additional Settings

Accessing Advanced Options

Scroll down to the bottom and click on "Show Advanced Options" to see all available settings or you can

type a keyword into the Filter settings box at the top to display a list of related settings.

The best way to search for a desired setting in this section is to open up the Advanced Options and use

CTRL + F to search for a specific keyword.

Categories of Settings

• System settings

• Staff settings

• Services settings

• Relationship settings

• Referral settings

• Medical settings

• Home settings

• Case settings

• Billing settings



Legacy Settings

Marked as "Legacy"

The following settings have been marked as "Legacy" and should not be used by agencies.

Questions?

If you have any questions about these settings or need an alternative set-up, please contact support@extendedreach.com.

Do Not Use

Settings like "Only allow agency administrators to edit activities marked as exported" and "Use DYMO LabelWriter for Home Addresses" are no

longer supported.



Advanced Password Options

Enable Advanced Options

When the setting "System: Use advanced password

options" is enabled the section Advance Password

Options will displayed and can be configured.

Character Requirements

Set requirements for lowercase, uppercase, numbers,

and special characters in passwords.

Security Rules

Prevent use of names, consecutive numbers/letters, or

duplicate characters in passwords.

Password Expiration

Require password changes every 1-12 months based

on your security policies.



Foster Parent Training Hours

Training Period

Select Calendar Year, License Period, or Fiscal Year

Required Hours

Set fixed hours or use a custom formula

Total Hours By

Calculate by parent, couple, or formula

Pro-rating Options

Customize for new licensees



Custom Labels

Field
Customization

Allow for labels to be

customized to match

titles/labels used by

the

agency/organization.

Home Labels

Customize Agency

Home #, Home

Worker, and

Secondary Home

Worker labels.

Case Labels

Customize Agency

Case #, Caseworker,

Secondary Foster

Worker, and

Secondary Adoption

Worker labels.

Header Text

Customize the

agency name

displayed in the

workspace header.



Home Activity Shortcuts

Select Activities

Choose two home activities to create quick access from the User's workspace screen

Choose Icons

Select icons to designate the specific home activities for quick access

Improve Efficiency

Provide users with one-click access to frequently used home activities



Understanding the Auditor

Role in extendedReach

The Auditor Role in extendedReach provides secure, read-only access to

case files, home records, and staff profiles for external reviewers and

auditors. This functionality allows organizations to grant temporary

access to specific information while maintaining appropriate security and

confidentiality controls. This presentation walks through the setup

process, functionality, and best practices for implementing the Auditor

Role in your extendedReach system.
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Auditor Role Overview

What Auditors Can Access

• Case files (activities, reports, documents)

• Home records (compliance documentation)

• Staff profiles (training records)

All access is read-only and can be customized based on specific audit requirements.

Organizations maintain complete control over which records auditors can view.

The auditor interface provides a streamlined view with basic information about each

record and filtering capabilities to quickly locate specific documents.



Prerequisites for Implementation

Foster Care/Residential System

The Auditor Role feature is exclusively available in Foster Care/Residential systems and

is not currently supported in General Case Management.

Full Administrator Permissions

Setting up the Auditor Role requires an extendedReach User ID with Full Administrator

permissions to enable the feature and create auditor accounts.

Manage Auditor Access Permission

Staff who will be granting and removing auditor access to specific records must have

the "Manage Auditor Access" permission enabled on their user profile.



Enabling the Auditor Role

Access Organization Preferences

Navigate to Side Menu → System Administration → Organization

Settings → Organization Preferences to access system configuration

settings.

Navigate to Settings Tab

Click on the "Settings" tab within Organization Preferences to find

security and access-related options.

Enable Auditor Role

Locate the "Enable Auditor Role" checkbox and select it to

activate this functionality. Click "Save" to apply the changes to

your system.



Creating an Auditor User ID

Add New User

Navigate to Side Menu → System Administration → User Management → User IDs and click "Add" to create a new user account.

Select Auditor Security Level

Choose "Auditor" from the Security Level dropdown menu. This automatically assigns appropriate permissions.

Configure Auditor Options

Decide whether to enable "Show Confidential Information" and "Show Health Information" based on audit requirements.

Save and Create Password

Complete the user creation process by saving the profile and setting up initial login credentials for the auditor.



Enabling Manage Auditor Access

Grant Permission to Staff

Navigate to the User ID for any staff

member who will be responsible for

granting auditor access to records.

Access Permission Settings

Click "Edit" on the user profile and

locate the "Manage Auditor Access"

permission under the appropriate

section.

Enable and Save

Check the box next to "Manage Auditor Access" and click "Save" to update the

user's permissions.

Staff members with this permission will see an "Auditor Access" button on the top

menu when viewing cases, homes, or staff profiles, allowing them to grant access to

auditors.



Granting Auditor Access

Access Record

Navigate to the case, home, or staff profile that requires auditor access.

Click Auditor Access

Look for the "Auditor Access" button in the top menu of the record and click

it.
Select Auditor and Duration

Choose the appropriate auditor from the dropdown list and specify how long

they should have access (days).
Save Settings

Click "Grant Access" to finalize permissions and notify the auditor that they

can now view the record.



Auditor Experience and Best Practices

100%

Read-Only Access

Ensures data integrity by preventing any

modifications to records

1

Day Limit

Maximum recommended access duration for

standard audits

3

Steps to Remove

Quick process to revoke access when audit is

complete



Understanding Email Alerts in

extendedReach

Email Alerts are a powerful feature within extendedReach that enable

automated communication about critical events in your case and home

management workflows. These pre-planned email messages announce

either "Action-Based" events (such as approvals) or "Scheduled" events (like

birthdays or court dates), ensuring that key stakeholders remain informed

about important developments within your organization.

With proper configuration, these alerts help maintain timely communication

across your team and external partners, reducing manual follow-up and

improving overall efficiency in your organization's operations.
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Administrator Access and Security Requirements

Required Permissions

You must have Agency

Administrator privileges to access

the Email Alerts configuration

section. This restriction ensures that

only authorized personnel can

create or modify organization-wide

notifications.

Navigation Path

From your Workspace, locate

"Administration" on the left side

menu, then select "Organization

Settings" and click on "Email Alerts"

to access the configuration area.

Security Considerations

Email alerts contain potentially

sensitive information about cases

and homes. Make sure to review

your organization's data privacy

policies when determining who

should receive specific types of

alerts.

Maintaining proper security controls for email alerts is essential, as these communications often contain confidential information

about clients and organizational activities. Consider implementing regular audits of your email alert configurations to ensure they

remain aligned with your current operational needs and security policies.





Creating New Email Alerts

Access the Email

Alerts Section

Navigate to Administration >

Organization Settings >

Email Alerts and click on

"Add Email Alert" to begin

the configuration process.

Configure General

Information

Enter an Alert Name (which

will auto-fill as the email

subject), set the Alert Status

to active, and select the

appropriate Agency if you

manage multiple

organizations.

Define Alert Event

Parameters

Specify whether the alert is

for a case or home, select

applicable programs, and

choose the Event Type that

will trigger the notification

(such as due dates,

approvals, or specific

milestones).

Set Recipients and

Message Content

Determine who receives the

alert, customize the subject

and body text, and decide

whether to include a link to

extendedReach in the

notification before saving

your configuration.

When creating alerts based on due dates or expiration dates, be precise with naming conventions. For due date alerts, list the exact

Activity/Report Type name. For expiration date alerts, use the exact name and append "Expires" to the end to ensure proper system

recognition.



Recipient Configuration Options

Primary Recipients

Select from role-based options including:

• Foster Care Caseworker

• Foster Care Supervisor

• Adoption Worker

• Adoption Supervisor

• Licensing Worker

• Licensing Supervisor

• Funding Worker

• Funding Supervisor

Distribution Lists

Leverage pre-configured distribution

channels:

• Foster Home

• Agency Distribution List (configured in

Organization Preferences)

• Branch Distribution List (configured in

Branch Profiles)

These options allow for efficient

communication to standardized groups

without having to maintain individual email

addresses.

Additional Recipients

Extend your communication reach by using:

• "Also Send to" for additional direct

recipients

• "Copy to" for carbon copy recipients

• "Blind Copy to" for confidential recipients

Multiple addresses can be included in each

field by separating them with commas.

When setting up recipients, consider the nature of the information being shared and ensure compliance with your organization's confidentiality

policies. External recipients should be informed that emails will arrive from alerts@extendedreach.com to prevent them from being filtered as

spam.





Message Content Customization

Subject Line

The email subject is

automatically

populated from the

Alert Name but can

be customized to

better reflect the

notification's

purpose.

Client Name

Enable the "Append

Client Name to

Subject" option to

automatically add the

relevant client's

name to the email

subject for easy

identification.

Body Content

Add detailed

information and

instructions in the

email body to provide

context and action

items for recipients.

System Link

Control whether to

include a direct link

to extendedReach in

the email by toggling

the "Do not include

link to

extendedReach"

option.

Creating effective email content is crucial for driving appropriate action. Use clear, concise language and include specific details

about what action is needed, who needs to take it, and by when. Consider including placeholders that will automatically populate

with relevant case information when the alert is triggered.



Special Considerations for Different Event Types

Due Date Alerts

When configuring alerts based on "x Days After Activity is Late",

"x Days After Report is Late", "x Days Before Activity Due Date",

or "x Days Before Report Due Date", you must specify the exact

name of the Activity/Report Type for proper system recognition.
Expiration Date Alerts

For alerts triggered by "x Days Before Any Expiration Date", list

the exact name of the Report/Activity and append the word

"Expires" to ensure the system correctly identifies the expiration

event.
Approval Workflow Alerts

When creating alerts for approval processes, consider setting up

notifications for both submission and completion to keep all

stakeholders informed throughout the workflow. Scheduled Event Alerts

For birthdays, court dates, and other calendar-based events,

determine the optimal timing for notifications to ensure adequate

preparation time for the relevant parties.

The timing of your alerts can significantly impact their effectiveness. Consider creating a sequence of alerts for critical deadlines, with initial reminders

sent well in advance and follow-up notifications as the deadline approaches.



Managing Existing Email Alerts

Edit Existing Alerts

Modify alert configurations as your organizational needs evolve

Deactivate Temporarily

Set status to "Inactive" to pause alerts without deletion

Delete Permanently

Remove alerts that are no longer needed

To modify an existing alert, navigate to the Email Alerts section, click on the blue hyperlinked Alert Title, then select "Edit" to make

changes or "Delete" to remove the alert entirely. If you want to temporarily disable an alert while preserving its configuration for future use,

change the "Alert Status" to "Inactive" instead of deleting it.

Regular audits of your email alert configurations can help ensure they remain relevant and effective. Consider reviewing all alerts

quarterly to confirm they still align with your organization's workflows and communication needs.



Best Practices and Troubleshooting

Test New Alerts

After creating a new alert, perform a test action that should

trigger the notification to verify it works as expected before

relying on it for operational purposes.

Inform Recipients

Let external recipients know that emails will come from

alerts@extendedreach.com and advise them to add this

address to their safe senders list to prevent notifications from

being filtered as spam.

Avoid Alert Fatigue

Be strategic about which events trigger alerts and who receives

them to prevent overwhelming staff with too many notifications,

which can lead to important alerts being overlooked.

Regular Maintenance

Schedule periodic reviews of your alert configurations to remove

outdated alerts, update recipient lists as staff changes occur,

and ensure alerts remain aligned with current workflows.

If alerts are not being received as expected, first verify the alert is set to "Active" status. Next, check that the event criteria are correctly configured

and that recipient email addresses are accurate. For role-based recipients, confirm that the appropriate staff members are correctly assigned to

those roles within the system.

Consider creating a documentation reference that outlines all configured alerts, their purposes, and their recipients to maintain organizational

knowledge about your notification strategy.



Pro Tip

Create a rule, folder, or label in your email to push all email alerts from extendedReach to a special folder. This will help you see

and find the alerts without having to go through your email.

• https://support.microsoft.com/en-us/office/create-a-folder-or-subfolder-in-outlook-3d3120d4-3c0e-4fef-b396-89b68324eba6

• Create a rule to push all emails from alerts@extendedreach.com to your extendedReach Email Alerts Folder, or use Label:

https://support.microsoft.com/en-us/office/manage-email-messages-by-using-rules-in-outlook-c24f5dea-9465-4df4-ad17-

a50704d66c59

https://support.microsoft.com/en-us/office/create-a-folder-or-subfolder-in-outlook-3d3120d4-3c0e-4fef-b396-89b68324eba6
https://support.microsoft.com/en-us/office/manage-email-messages-by-using-rules-in-outlook-c24f5dea-9465-4df4-ad17-a50704d66c59
https://support.microsoft.com/en-us/office/manage-email-messages-by-using-rules-in-outlook-c24f5dea-9465-4df4-ad17-a50704d66c59
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https://support.microsoft.com/en-us/office/manage-email-messages-by-using-rules-in-outlook-c24f5dea-9465-4df4-ad17-a50704d66c59
https://support.microsoft.com/en-us/office/manage-email-messages-by-using-rules-in-outlook-c24f5dea-9465-4df4-ad17-a50704d66c59
https://support.microsoft.com/en-us/office/manage-email-messages-by-using-rules-in-outlook-c24f5dea-9465-4df4-ad17-a50704d66c59
https://support.microsoft.com/en-us/office/manage-email-messages-by-using-rules-in-outlook-c24f5dea-9465-4df4-ad17-a50704d66c59
https://support.microsoft.com/en-us/office/manage-email-messages-by-using-rules-in-outlook-c24f5dea-9465-4df4-ad17-a50704d66c59
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https://support.microsoft.com/en-us/office/manage-email-messages-by-using-rules-in-outlook-c24f5dea-9465-4df4-ad17-a50704d66c59
https://support.microsoft.com/en-us/office/manage-email-messages-by-using-rules-in-outlook-c24f5dea-9465-4df4-ad17-a50704d66c59
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